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NOTICE:
Warnings and Cautions appear at appropriate sections throughout this manual. Read these carefully:

�WARNING
Indicates a potentially hazardous situation, which, if not avoided, could result in death or serious injury.

�CAUTION
Indicates a potentially hazardous situation, which, if not avoided, may result in minor or moderate injury. 

It may also be used to alert against unsafe practices.

CAUTION
Indicates a situation that may result in equipment or property-damage-only accidents.

The following format and symbol conventions appear at appropriate sections throughout this manual:

IMPORTANT
Alerts installer, servicer, or operator to potential actions that could cause the product or system to 

operate improperly but will not likely result in potential for damage.

Note:

A note may be used to make the reader aware of useful information, to clarify a point, or to describe 
options or alternatives.
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Chapter 1

Overview

The Tracer MP581 programmable controller is a general-purpose, input/
output device. The controller provides direct digital control of a variety of 
HVAC equipment.

The Tracer MP580 is factory-installed on Modular Climate Changer and 
on T-Series air handlers. The controller is factory wired to all sensors, 
actuators, valves, starters, and other items shipped with the air handler. 

Use this programming guide to configure and program the Tracer MP580/
581. 

Tracer MP580/581 plug-in
The Rover service tool is the setup and configuration tool for the Tracer 
MP580/581. It is analogous to PCM Edit for the PCM and UPCM Edit for 
the UPCM. For more information about the Rover service tool, see the 
Rover Operation and Programming guide (EMTX-SVX01E-EN).

To access the device through the Rover service tool, you must have the 
Tracer MP580/581 plug-in. The plug-in is a software file that Rover con-
nects with internally to display information and set up configuration for 
the device. The plug-in also contains extensive online Help to help you 
access and change device information. 

The Tracer MP580/581 plug-in can be run with Rover Version 4 and 
higher. You cannot run the Tracer MP580/581 plug-in with an earlier ver-
sion of Rover. Updated versions of the Tracer MP580/581 plug-in may be 
released independently from the Rover software. Contact your local sales 
office for the latest versions of the Rover device plug-ins.

Using Rover service tool
Within Rover, you can access not only status and configuration informa-
tion but also other applications specific to the Tracer MP580/581.

Accessing the Tracer MP580/581

The Rover service tool communicates to Tracer MP580/581 controllers 
through a connection to a Comm5 communication link. Comm5 is Trane’s 
implementation of LonTalk®. When you start Rover on an active Comm5 
communication link, all communicating devices appear in the Active 
Group tree. To access information for a specific device, click that device in 
the tree. The device status information appears in the Active Device View 
CNT-SVP01C-EN 1



Chapter 1 Overview
workspace (Figure 1). Use the nine tabs of status information, the seven 
command buttons, and this guide to work with the device.

Figure 1. Rover application window

Using online Help

The Rover service tool includes online Help for each screen and dialog box 
in the plug-in. The extensive online Help does not appear in this guide. To 
access Help for a tab or dialog box, click the Help button. For information 
about a screen element, such as a field, option, or command button, click 
the What’s This? help question mark icon and then click a field. You 
can also choose What’s This? from the Help menu and then click a field. 

Active
Group

tree

Status tabs

Plug-in 
command 
buttons

Workspace
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Chapter 2

Viewing status

Before viewing the status or configuration of a Tracer MP580/581 control-
ler, you must first select the Tracer MP580/581 you are working with on 
the Comm5 link. To select the device, click the device name in the Active 
Group tree. The Active Device View appears in the workspace (Figure 2). 
The Active Device View contains nine tabs of status information. The 
Unit tab is displayed when you first access a device.

The Unit tab displays general status information about the device. The 
status information contains the operating status, today’s date and time, 
active diagnostics, and expansion module communication status.

Figure 2. Tracer MP580/581 Active Device View in Rover service tool
CNT-SVP01C-EN 3



Chapter 2 Viewing status
Viewing the status of inputs
Universal hardware inputs and an additional input for a pressure sensor 
are provided on the Tracer MP580/581 controller. The configurable inputs 
may be set up as analog or binary. Furthermore, analog inputs may be 
configured to accommodate resistance, voltage, or current. You can view 
the status of each input as well as its corresponding raw value. For infor-
mation on configuring inputs, see “Configuring inputs” on page 21.

To view the status of inputs:

In the Active Device View, click the Inputs tab (Figure 3).

Figure 3. Device status Inputs tab
4 CNT-SVP01C-EN



Viewing the status of binary and analog outputs
Viewing the status of binary and 

analog outputs
You can view the current status of each hardware output, binary and ana-
log, on the Tracer MP580/581. The status table includes what is currently 
controlling the output. Valid control sources, in order of priority, are as 
follows (“None” is displayed if there is no control source):

• Operator display or Rover service tool (highest priority)
• Program within the Tracer MP580/581 controller
• Tracer Summit building automation system

To view the status of binary and analog outputs:

In the Active Device View, click the BOs tab (Figure 4) for the status 
of the binary outputs or the AOs tab (Figure 5 on page 6) for the sta-
tus of the analog outputs.

Figure 4. Device status BOs tab
CNT-SVP01C-EN 5



Chapter 2 Viewing status
Figure 5. Device status AOs tab

Overriding binary and analog outputs
You can override both binary and analog outputs. Upon override, the 
selected output value changes to the override value. The control source of 
the output becomes the operator display/service tool so that other control 
sources cannot change the value of the output. 

To override a binary or analog output:

1. In the Active Device View, click the BOs tab to view the binary out-
puts or the AOs tab to view the analog outputs.

2. Click the name of the output in the table that you want to override.

3. Click the Override button. The Override Binary Output dialog box 
(Figure 6 on page 7) or the Override Analog Output dialog box 
(Figure 7 on page 7) appears.

Note:

Overrides are maintained through a power loss.
6 CNT-SVP01C-EN



Overriding binary and analog outputs
Figure 6. Override Binary Output dialog box

Figure 7. Override Analog Output dialog box

4. Click the desired override option for binary outputs (Figure 6) or type 
the desired override value for analog outputs (Figure 7).

5. Click the Override button. The Current Status field updates, and the 
word “Override” appears in bold, blue text (Figure 8 on page 8).

The words “Minimum On/Off” may appear showing that the output 
must remain in its current state for the amount of time specified on 
the Configuration BOs tab.
CNT-SVP01C-EN 7



Chapter 2 Viewing status
Figure 8. Binary output with override

6. Click Close. The override status of the output appears in the table 
(Figure 9). The control source becomes the operator display/service 
tool.

Figure 9. BOs status table with an output override

Override 
indicator

Note:

You can also override a binary or analog output from the Dis-
plays tab. Binary and analog outputs must be designated as 
adjustable in the display configuration to apply an override to 
them. For more information on setting an output to adjustable, 
see “Configuring the operator display” on page 39.
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Releasing binary and analog output overrides
Releasing binary and analog output 

overrides
You can release overrides of both binary and analog outputs. Upon 
release, the selected output value is released back to normal control. The 
control source of the output returns to its original source. To release a 
binary or analog output override:

1. In the Active Device View, click the BOs tab to view the binary out-
puts or the AOs tab to view the analog outputs.

2. Click the output in the table that has its value overridden.

3. Click the Override button. The Override Binary Output dialog box 
(Figure 8 on page 8) or the Override Analog Output dialog box 
appears.

4. Click the Release button. The Current Status field returns to its orig-
inal value.

5. Click Close. The status of the output appears in the list.

Viewing the status of binary and 

analog variables
Variables may be changed using a variety of methods. Variables can be 
communicated from the Tracer Summit system and changed using the 
Rover service tool. Variables may also be calculated in a program, or they 
may be made adjustable through the operator display. The Tracer MP580/
581 accommodates 150 binary and 150 analog variables. 

Tracer Summit variables 1 through 30 are reserved for use with the 
Tracer Summit building automation system. There are 120 variables con-
trolled by the operator display/service tool and/or programs. These 120 
variables are called local variables. You can view the status of each binary 
and analog variable. 

To aid in troubleshooting, the status table includes the control source 
assigning the variable its value. For information on configuring binary 

Note:

You can also release a binary or analog output override from 
the Displays tab.
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Chapter 2 Viewing status
and analog variables, see “Configuring variables” on page 31. Valid con-
trol sources include the following:

• Operator display or Rover service tool
• Program within the Tracer MP580/581 controller
• Tracer Summit building automation system

To view the status of binary and analog variables:

1. In the Active Device View, click the BVs tab (Figure 10) for the status 
of the binary variables or the AVs tab (Figure 11 on page 11) for the 
status of the analog variables.

2. Click the Tracer Summit Binary Variables option, the Local Binary 
Variables option, the Tracer Summit Analog Variables option, or the 
Local Analog Variables option to view the list of variables you want.

Uploading the variables may take a few seconds.

Figure 10. Device status BVs tab displaying local binary variables

Note:

When Tracer Summit is the control source, no graphical pro-
gramming is required. The variable can be controlled directly.

Local Binary
Variables option
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Viewing the status of binary and analog variables
Figure 11. Device status AVs tab displaying Tracer Summit analog 

variables

Tracer Summit Analog
Variables option
CNT-SVP01C-EN 11



Chapter 2 Viewing status
Viewing application status
You can view the status of the Schedule and standard Calculations appli-
cations. On the Application tab under Schedule, view the current occu-
pancy state of the controller as well as the day and time in the controller. 
Under Calculations, view the table that displays the calculations present 
in the controller as well as the calculation type, units, and values.

To view the application status:

In the Active Device View, click the Application tab (Figure 12).

Figure 12. Device status Application tab
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Viewing Comm5 parameters
Viewing Comm5 parameters
To view information about the Tracer MP580/581 controller Comm5 
parameters:

In the Active Device View, click the General tab. Comm5 information 
specific to the selected Tracer MP580/581 controller is displayed 
(Figure 13).

Figure 13. Device status General tab
CNT-SVP01C-EN 13
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Viewing custom displays
You can set up custom displays for the Tracer MP580/581 operator dis-
play through the Rover service tool. A custom display is a group of inputs, 
outputs, and variables saved under a descriptive name. You can view the 
status of the items in the group from the operator display or Rover by 
accessing the custom display name. Variables and outputs may also be 
changed or overridden from the display if they are configured as adjust-
able. For more information on configuring custom displays, see “Configur-
ing custom displays” on page 41.

To view custom displays:

1. In the Active Device View, click the Displays tab.

2. In the Display drop-down list, click the custom display you want to 
view. The names, values, and control sources for the items in the 
group appear (Figure 14).

Figure 14. Device status Displays tab
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Changing binary and analog variables
Variables are often used for setpoints so that they can be changed by the 
building operator or owner from the operator display. In the Rover service 
tool, binary and analog variables can be changed from the Displays tab. 
To make a change from the Displays tab or from the operator display, the 
following must be true:

• The variable must be a local variable with the control source set to 
the operator display/service tool. For information on configuring 
binary and analog variables, see “Configuring variables” on page 31.

• The variable must be designated as adjustable in the display configu-
ration. For information on setting a variable to be adjustable, see 
“Configuring custom displays” on page 41.

Upon changing, the selected variable value changes to the requested 
value. The control source of the variable does not change, so other control 
sources, such as the operator display, can still affect the value of the vari-
able.

To change a binary or analog variable in the Rover service tool:

1. In the Active Device View, click the Displays tab.

2. In the Display list, click the name of the custom display that contains 
the variable you want to change.

3. In the table, click the name of the variable you want to change.

4. Click the Change button. The Change Local Analog Variable dialog 
box appears (Figure 15 on page 16).

Note:

Variables cannot be changed from the home display on the oper-
ator display or in the Rover service tool.

Note:

If the Change button is not available, the variable you chose 
does not meet the criteria outlined previously.
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Figure 15. Change Local Analog Variable dialog box

5. Click the desired state for binary variables or type the desired value 
for analog variables.

6. Click the Change button. The value of the variable is changed.

7. Click Close. The changed value appears in the table.

Overriding the occupancy mode
You can override the effective occupancy of the Tracer MP580/581 control-
ler. An occupancy override from the operator display or the Rover service 
tool takes priority over all other occupancy requests.

Applying an occupancy override

Upon override, the occupancy value of the Tracer MP580/581 controller 
changes to the override value. The control source of the output becomes 
the operator display/service tool, preventing other control sources from 
changing the occupancy.

To apply an occupancy override:

1. In the Active Device View, click the Unit tab.

2. Click the Override Unit button. The Override Unit Occupancy dialog 
box appears (Figure 16 on page 17).
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Overriding the occupancy mode
Figure 16. Override Unit Occupancy dialog box

3. In the Override list, click the occupancy mode you want.

4. Click the Override button. The current status is changed to the over-
ride mode.

5. Click Close. The Override Unit Occupancy dialog box closes.

Releasing an occupancy override

You can release an occupancy override of the Tracer MP580/581. Upon 
release, the occupancy value of the selected device is released to normal 
control. The control source of the output becomes the normal source.

To release an occupancy override:

1. In the Active Device View, click the Unit tab.

2. Click the Override Unit Occupancy button. The Override Unit Occu-
pancy dialog box appears.

3. Click the Release button. The current status is changed to the normal 
mode.

4. Click Close. The Override Unit Occupancy dialog box closes.
CNT-SVP01C-EN 17
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Chapter 3

Configuring the 

Tracer MP580/581

Use the information in this chapter to configure your Tracer MP580/581 
controller. Select the Tracer MP580/581 you want to configure from the 
Active Group tree and then click the Configuration button. The Configu-
ration dialog box appears with the same tab selected as the tab that was 
showing in the Active Device View. You can jump from tab to tab within 
the Configuration dialog box without going back to the status tabs in the 
Active Device View.

Configuring EX2 expansion modules
The EX2 expansion module is a field-installed expansion module for the 
Tracer MP580/581 programmable controller. 

Up to four EX2s can be connected to a Tracer MP580/581. Each EX2 adds 
the following inputs and outputs to a Tracer MP580/581:

• 6 universal inputs
• 4 binary inputs
• 4 analog outputs

To set up an EX2 expansion module that has been connected to a Tracer 
MP580/581:

1. In the Active Device View, click the Unit tab. The status information 
for the controller appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Unit tab displayed (Figure 17 on page 20).

3. Under Expansion Module Configuration, in the Expansion Module 
Type column, choose the expansion module row for the module you 
want to configure. In the list, click the appropriate module type. The 
rest of the row fills in with indexes for universal inputs, binary out-
puts, and analog outputs.

Note:

This feature applies to only Tracer MP580/581 Firmware Revi-
sion 2 or higher. Follow the procedure for “Viewing Comm5 
parameters” on page 13 to view your current revision number.
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Figure 17. Device configuration Unit tab

The expansion module number is configured by setting the DIP 
switch on the module. See the Tracer MP581 Programmable Control-
ler Hardware Installation guide (CNT-SVN01B-EN) for more infor-
mation.

4. Click the Download button to send your changes to the Tracer 
MP580/581. (If the Security Logon dialog box appears, log on.) Click 
Close to close the Configuration dialog box.

5. See “Configuring inputs” on page 21 and “Configuring outputs” on 
page 28 for instructions on configuring inputs and outputs for the 
expansion modules.
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Configuring inputs
Universal hardware inputs and an additional input for a pressure sensor 
are provided on the Tracer MP580/581 controller. The configurable inputs 
on the controller may be set up as analog or binary. You can configure all 
inputs on the controller and any of the expansion modules with the name 
and type information. Futhermore, you can configure analog inputs to 
accommodate various temperature sensors or to accept a linear resis-
tance, voltage, or current signal. For example, on a zone temperature sen-
sor the linear resistance values for a thumbwheel are displayed in 
Table 1:

Configuring binary inputs

A binary input detects whether a circuit is open or closed, indicating on or 
off status.

To set up a binary input:

1. In the Active Device View, click the Inputs tab. The status informa-
tion for the inputs appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Inputs tab displayed (Figure 18, page 22).

Table 1. Thumbwheel linear resistance values

Temperature 
(°F)

Value (Ω)

50°F 889.4 Ω
90°F 110.6 Ω
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Figure 18. Device configuration Inputs tab

3. In the Name list, click the input you want to configure. The configura-
tion information for that input appears in the tab.

You can also select the input by clicking the input number in the 
Input list. The Name and Input lists are linked so that input name 
and input number are always displayed together.

4. If you want to change the input name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

5. Under Type, click the Binary option. The binary input configuration 
information appears (Figure 19).
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Figure 19. Device configuration binary input

6. Under Input Definition, type descriptors for the open and closed 
states of the binary input.

Use descriptive terms because they appear on the operator display 
and the Rover status displays.
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7. Complete one of the following options:

• Click another input name in the Name list to edit another input.
• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring analog inputs

An analog input is a varying voltage, current, or resistance signal that 
can be converted to units of measurement, such as temperature, pressure, 
and humidity.

To set up an analog input:

1. In the Active Device View, click the Inputs tab. The status informa-
tion for the inputs appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Inputs tab displayed (Figure 18 on page 22).

3. In the Name list, click the input you want to configure. The configura-
tion information for that input appears in the tab.

You can also select the input by clicking the input number in the 
Input list. The Name and Input lists are linked so that input name 
and input number are always displayed together.

4. If you want to change the input name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

5. Under Type, click the Analog option. The analog input configuration 
information appears (Figure 20 on page 25).
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Figure 20. Device configuration analog input

6. In the Type list, click the input type. 

7. In the Units list, click the units associated with the input.

8. In the Decimal Places list, click the number of digits you want to 
appear to the right of the decimal when displaying the input value.

Determine how many digits appear to the right of the decimal in the 
Rover Active Device View and on the Tracer MP580/581 operator dis-
play. Use the resolution of the sensor to determine the number of dec-
imal places. For example, if a temperature sensor is accurate to 0.1°F, 
do not display more than one decimal place. However, a differential 
pressure sensor input may need to display two or three decimal 
places.

Note:

Only the first four universal inputs (Input 01 to Input 04) can 
be configured as a Balco or platinum resistance temperature 
detector (RTD). Only the first two universal inputs on each EX2 
expansion module can be configured as Balco or platinum 
RTDs.
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9. Click to select the Fail at End of Range check box if you want the con-
troller to generate a diagnostic whenever the analog input is within 
3% of the end of its range.

For example, a 0–10 V sensor will generate a diagnostic whenever its 
raw value is less than 0.3 V or greater than 9.7 V.

10. If the input requires calibration, type the amount you want to adjust 
the value of the input in the Calibration Factor field.

For example, if you know a temperature sensor is reading 1°F too 
high, type a calibration factor of –1°F.

11. For linear-voltage, -current, or -resistance inputs, type the low and 
high sensor values and sensor outputs in the Low and High Sensor 
Value and Sensor Output fields.

The Sensor Value Low is the lowest reading the sensor can provide, 
while the Sensor Value High is the highest reading the sensor can 
provide. For example, a humidity sensor provides a 4–20 mA signal 
corresponding to 0–100% relative humidity. Type 0 as the low sensor 
value and 100 as the high sensor value in this case. The sensor cali-
bration is determined by these four parameters. In this example, type 
4 mA as the low sensor output and 20 mA as the high sensor output.

12. Complete one of the following options:

• Click another input name in the Name list to edit another input.
• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring pulse inputs

A pulse input measures the number of contact closures over time. Typical 
origins of contact closures include electric, gas, and water meters. The 
meter must have a dwell time of 200 ms and a maximum pulse rate of 
3 pulses per second.

To set up a pulse input:

1. In the Active Device View, click the Inputs tab. The status informa-
tion for the inputs appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Inputs tab displayed (Figure 18 on page 22).

3. In the Name list, click the input you want to configure. The configura-
tion information for that input appears in the tab.

You can also select the input by clicking the input number in the 
Input list. The Name and Input lists are linked so that the input 
name and input number are always displayed together.
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4. If you want to change the input name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

5. Under Type, click the Pulse option. The pulse input configuration 
information appears (Figure 21).

Figure 21. Device configuration pulse input

6. In the Units list, click the units associated with the input.

7. In the Pulse Weight field, type the value per contact closure from the 
meter.

8. Complete one of the following options:

• Click another input name in the Name list to edit another input.
• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.
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Configuring outputs
The Tracer MP580/581 and expansion modules include binary and analog 
hardware outputs.

Configuring binary outputs

You can name binary outputs, specify open and closed descriptors, and set 
minimum on and off times.

To set up a binary output:

1. In the Active Device View, click the BOs tab. The status information 
for the binary outputs appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the BOs tab displayed (Figure 22).

Figure 22. Device configuration BOs tab

3. In the Name list, click the output you want to configure. The configu-
ration information for that output appears in the tab.

You can also select the output by clicking the output number in the 
BO list. The Name and BO lists are linked so that the output name 
and output number are always displayed together.
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4. If you want to edit the output name, highlight the text and type a new 
name.

Use a descriptive name because it appears in custom displays and 
programs.

5. Under Output Definition, type descriptors for the open and closed 
states of the binary output.

Use descriptive terms because they appear on the operator display 
and the Rover status displays.

6. Under On/Off Times, type the minimum on and off times.

The minimum off time is the least amount of time the output must be 
off before it can go to on. The minimum on time is the least amount of 
time the output must be on before it can go to off.

7. Complete one of the following options:

• Click another output name in the Name list to edit another out-
put.

• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring analog outputs

You can name an analog output, specify its type, display its units and 
numeric format, and perform calibration.

To set up an analog output:

1. In the Active Device View, click the AOs tab. The status information 
for the analog outputs appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the AOs tab displayed (Figure 23 on page 30).
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Figure 23. Device configuration AOs tab

3. In the Name list, click the output you want to configure. The configu-
ration information for that output appears in the tab.

You can also select the output by clicking the output number in the 
AO list. The Name and AO lists are linked so that output name and 
output number are always displayed together.

4. If you want to change the output name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

5. In the Type list, click the analog output type. This selection sets the 
default values under Calibration.

6. In the Units list, click the appropriate units.

7. In the Decimal Places list, click the number of digits you want to 
appear to the right of the decimal.

You determine how many digits appear to the right of the decimal in 
the Rover Active Device View and on the Tracer MP580/581 operator 
display. 

8. If the output requires calibration, type the amount by which you want 
to adjust the value of the output in the Calibration Factor field.
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9. Verify the open and close values and the open and close outputs, and 
type new values in the Close and Open Output and Value fields if nec-
essary.

The output values are the hardware output voltage or current corre-
sponding to the open and closed states of the wired device. The analog 
output calibration is determined by these four parameters.

10. Click to select the Secondary Control (E-P) check box if a secondary 
control device is used and type the open and close values and outputs 
for the secondary control device.

11. Complete one of the following options:

• Click another output name in the Name list to edit another out-
put.

• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring variables
Variables may be changed using a variety of methods. Variables can be 
communicated from the Tracer Summit system and changed using the 
Rover service tool. Variables may also be calculated in a program, or they 
may be made adjustable through the operator display. The Tracer MP580/
581 accommodates 150 binary variables and 150 analog variables.

Configuring binary variables

Tracer Summit binary variables 1 through 30 are reserved for use with 
the Tracer Summit system. Use local binary variables 1 through 120 as 
local variables. You can edit the Tracer Summit variables or the local 
variables. For each binary variable, specify a name, control source, off and 
on descriptors, and a communications loss value or initial value.

To set up a binary variable:

1. In the Active Device View, click the BVs tab. The status information 
for the binary variables appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the BVs tab displayed.

3. Click the Tracer Summit Binary Variables option or the Local Binary 
Variables option to view the type of variable you want to edit 
(Figure 24 on page 32).
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Figure 24. Device configuration BVs tab

4. In the Name list, click the variable you want to configure. The config-
uration information for that variable appears in the tab.

You can also select the variable by clicking the variable number in the 
BV list. The Name and BV lists are linked so that the variable name 
and variable number are always displayed together.

5. If you want to change the variable name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

6. If the variable is not a Tracer Summit variable, click the control 
source for the variable in the Source list.

7. If the variable is local and is controlled by the operator display/service 
tool, click to select the Allow Program Control Source check box if you 
want to also control this variable within a program.

It is not recommended you select this unless you have a specific pur-
pose in mind, for example, you are using the program to return an 
alarm reset variable to normal.

8. Under Variable Definition, type descriptors for the on and off states of 
the binary variable.

Use descriptive terms because they appear on the operator display 
and the Rover status displays.
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9. If the variable has Tracer Summit as its control source, under Com-
munications Loss Value, click the On or Off option to determine what 
value you want to appear as the value if Tracer Summit communica-
tions are lost to the Tracer MP580/581.

10. If the variable has the operator display and service tool as its control 
source, under Value, click the On or Off option to determine what 
value you want the variable to have.

11. Complete one of the following options:

• Click another variable name in the Name list to edit another vari-
able.

• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring analog variables

Tracer Summit analog variables 1 through 30 are reserved for use with 
the Tracer Summit system. The 120 local analog variables are to be used 
as local variables. You can edit the Tracer Summit variables or the local 
variables. For each analog variable, specify a name, control source, dis-
play units, numeric format, and communications loss or initial value.

To set up an analog variable:

1. In the Active Device View, click the AVs tab. The status information 
for the analog variables appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the AVs tab displayed (Figure 25 on page 34).

Note:

The variable value is saved once every 24 hours. If a power loss 
occurs, the variable value is set to the last saved value.
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Figure 25. Device configuration AVs tab

3. Click the Tracer Summit Analog Variables option or the Local Analog 
Variables option to view the type of variable you want to edit.

4. In the Name list, click the variable you want to configure. The config-
uration information for that variable appears in the tab.

You can also select the variable by clicking the variable number in the 
AV list. The Name and AV lists are linked so that the variable name 
and variable number are always displayed together.

5. If you want to change the variable name, highlight the text and type a 
new name.

Use a descriptive name because it appears in custom displays and 
programs.

6. If the variable is not a Tracer Summit variable, click the control 
source for the variable.

7. If the variable is local and is controlled by the operator display/service 
tool, click to select the Allow Program Control Source check box if you 
want to also control this variable within a program.

It is not recommended you select this unless you have a specific pur-
pose in mind.

8. In the Units list, click the appropriate units.
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9. In the Decimal Places list, click the number of digits you want to 
appear to the right of the decimal when the variable value is dis-
played.

10. If the variable has Tracer Summit as its source, under Communica-
tions Loss Value, type the value you want to appear if Tracer Summit 
communications are lost to the Tracer MP580/581.

11. If the variable has the operator display and service tool as its source, 
under Value, type the value you want the variable to have. 

12. Complete one of the following options:

• Click another variable name in the Name list to edit another vari-
able.

• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box.

Configuring user security
A user who has security supervisor access can set up security privileges 
for up to eight users, giving each different access privileges, for both the 
Tracer MP580/581 operator display and the Rover service tool. Any user 
can view all displays on the Tracer MP580/581 operator display; however, 
a security supervisor can set up security to prevent unauthorized users 
from changing variables or overriding outputs at the operator display.

A security supervisor can also set up security to prevent unauthorized 
users from downloading or deleting variables, overriding inputs, down-
loading or deleting a Tracer graphical program, clearing memory on the 
controller, and performing a flash download to the controller.

After security is established, users are prompted to log on with a pass-
word when they attempt to perform security-protected functions. 

Note:

The variable value is saved once every 24 hours. If a power loss 
occurs, the variable value is set to the last saved value.

Note:

A logged-on user loses access to security-protected functions if 
an action is not performed for 30 minutes. 
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To configure security:

1. In the Active Device View, click the Unit tab. The status information 
for the controller appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Unit tab displayed.

3. Click the Security Setup button. The Security dialog box (Figure 26) 
appears.

Figure 26. Security dialog box

4. In the User Name list, click the user name for which you want to set 
up security.

5. If you want to change the user name, type the user’s name in the User 
Name field.

The user name can be up to 24 characters long.

6. In the User Password field, type a four-digit password.

The password can be only numbers; no letters or special characters 
are allowed.

7. Click to select the Show Password check box to display the password 
for the selected user name.
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8. If needed, click to select the Security Supervisor check box to set the 
selected user as a security supervisor. 

At least one user must be declared a security supervisor. After any 
default settings have changed, only a security supervisor can change 
the security configuration.

9. Under Operator Display Access, click to select the check boxes for the 
displays and items you want the selected user to be able to adjust. 
Click to clear the check boxes for the displays and items this user is 
not allowed to adjust.

The first six check boxes are for the custom displays. The last three 
check boxes are for standard displays.

10. Under Rover/TGP Options, click to select the check boxes to allow the 
selected user to modify configurations and TGP programs and to be 
able to clear memory or download a new program to the Tracer 
MP580/581.

11. Repeat steps 4–10 to set up additional users.

12. Click the Download button to send your changes to the Tracer 
MP580/581. If the Security Logon dialog box appears, log on. Click 
Close to close the Configuration dialog box.

Setting the time and date
Set the time and date for the Tracer MP580/581 and the format in which 
you want the time to appear in the Rover service tool and on the operator 
display.

To set the time and date:

1. In the Active Device View, click the Unit tab. The status information 
for the controller appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Unit tab displayed (Figure 17 on page 20).

3. Under Time Format, click the option for the format in which you want 
the time to appear.

4. Under Display, click the Set Date/Time button. (If the Security Logon 
dialog box appears, log on.) The Set Date/Time dialog box appears 
(Figure 27 on page 38).
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Figure 27. Set Date/Time dialog box

5. To select the date and time you want to use, choose one of the follow-
ing options:

• If you want to apply the current date and time settings of the PC 
to the controller, click to select the Use PC System Date/Time 
check box.

• If you want to set the date and time for the controller yourself, 
click to clear the Use PC System Date/Time check box. Then click 
the date in the calendar and type the time. Click to select the 
check box if you want to automatically adjust the time for Day-
light Savings Time.

6. Click the Set button to apply your changes.

7. Click the Download button to send your changes to the Tracer 
MP580/581. If the Security Logon dialog box appears, log on. Click 
Close to close the Configuration dialog box.

Configuring timers
Set up the occupied bypass, power-up control wait, and minimum send 
times for the Tracer MP580/581.

To set up timers:

1. In the Active Device View, click the Unit tab. The status information 
for the controller appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Unit tab displayed (Figure 17 on page 20).

3. In the Occupied Bypass Timer field, type the amount of time you 
want the controller to remain in occupied bypass mode.

When a user overrides the controller to occupied bypass mode, it stays 
in this mode for the time specified here. This field is not available if 
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an SCC or DAC profile is active. If a profile is active, you must set the 
occupied bypass timer on the SCC or DAC Configuration tab.

4. In the Power-up Control Wait field, type the amount of time after 
power-up you want the controller to wait before controlling analog or 
binary outputs.

5. In the Minimum Send Time field, type the minimum number of sec-
onds between the automatic output of network variable transmis-
sions. Only one output network variable can be updated within a 
single minimum-send-time period.

6. Click the Download button to send your changes to the Tracer 
MP580/581.

7. Click Close to close the Configuration dialog box.

Configuring the operator display
You can view custom displays from the Rover service tool as well as from 
the Tracer MP580/581 operator display. So, custom displays are useful 
even when the Tracer MP580/581 does not have a local operator display 
connected. In addition, a portable operator display temporarily connected 
to the device uses the custom displays.

Use custom displays to logically group the information available in the 
Tracer MP580/581. Seven custom displays are available. The first display 
is a home display that contains a name and two items. The home display 
name appears as the title on the operator display. You can also name the 
other six custom displays. Each custom display consists of four screens of 
four items, for a total of up to 96 items.

Within a custom display, assign each line to display an input, output, or 
variable. Leave a display item blank to break a display into subgroups. 
Custom displays allow you to group information by category or by equip-
ment, rather than by point type. For example, all the information perti-
nent to the cooling tower may be shown on one custom display. Variables 
and outputs may be changed or overridden from the custom displays if 
the items are configured as adjustable.

Configuring the home display

The home display contains a name or title and two items. The home dis-
play name appears as the title on the home screen of the operator display. 
The status of the two items is displayed on the home screen as well.

To set up the home display:

1. In the Active Device View, click the Displays tab. The status informa-
tion appears for the custom displays.

2. Click the Configuration button. The Configuration dialog box appears 
with the Displays tab displayed (Figure 28).
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Figure 28. Device configuration Displays tab

3. In the Name list, click Home Display. The configuration information 
appears in the tab.

4. If you want to change the display name, highlight the text and type a 
new name.

Use a descriptive name because it appears on the operator display 
and the Active Device View workspace.

5. Click in the first row of the Type column. Click the down arrow. The 
Type list appears.

6. In the Type list, click the type of item you want to display.

The types include: inputs, outputs, and variables.

7. Click in the first row of the Display Item Name column. Click the 
down arrow. The Display Item Name list appears.

8. In the Display Item Name list, click the name of the item you want to 
display.

9. Repeat steps 5–8 for row 2.

10. Complete one of the following options:

• Click another display name in the Name list to edit another dis-
play. 

• Click another tab to set up another item.
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• Click the Download button to send your changes to the Tracer 
MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box. The changes 
appear on the operator display touch screen (Figure 29).

Figure 29. Home display on the operator display

Configuring custom displays

You can set up six custom displays to be displayed in the Rover Active 
Device View workspace or on the operator display. Give each display a 
descriptive name and assign up to 16 items to the display.

To set up custom displays:

1. In the Active Device View, click the Displays tab. The status informa-
tion for the custom displays appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Displays tab displayed (Figure 30 on page 42).
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Figure 30. Device configuration Displays tab custom display

3. In the Name list, click the display you want to configure. The configu-
ration information for that display appears in the tab.

You can also select the display by clicking the display number in the 
Display list. The Name and Display lists are linked so that display 
name and display number are always displayed together.

4. If you want to change the display name, highlight the text and type 
the new name.

Use a descriptive name because it appears on the operator display 
and the Active Device View workspace.

5. Click in the first row of the Type column. Click the down arrow. The 
Type list appears.

6. In the Type list, click the type of item you want to display.

The types include: inputs, output, and variables.

7. Click in the first row of the Display Item Name column. Click the 
down arrow. The Display Item Name list appears.

8. In the Display Item Name list, click the name of the item you want to 
display.
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9. For outputs and variables with an operator display/service tool con-
trol source, click to select the check box in the Adjustable column if 
you want the item to be adjustable.

If a variable is adjustable, it can be changed from the operator dis-
play. For information on setting a variable control source, see “Config-
uring variables” on page 31. If an output is adjustable, it can be 
overridden from the operator display.

10. If the item is an analog output or variable, and it is adjustable, type 
the low and high limits in the columns.

11. Repeat steps 5 through 10 for additional items you want in the cus-
tom display.

Leave blank rows to separate groups of items in the display. Four 
items appear per screen on the operator display.

12. Complete one of the following options.

• Click another display name in the Name list to edit another dis-
play.

• Click another tab to set up another item.
• Click the Download button to send your changes to the Tracer 

MP580/581. (If the Security Logon dialog box appears, log on.) 
Click Close to close the Configuration dialog box. The changes 
appear on the operator display custom screen (Figure 31).

Figure 31. Custom screen on the operator display
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Configuring an SCC or DAC profile
You can set up the Tracer MP580/581 to provide a network interface 
according to the Space Comfort Controller (SCC) or Discharge Air Con-
troller (DAC) profile. To implement a one of these profiles, you must com-
plete the following: 

• Activate the profile.
• Configure the interface.
• Write a program to implement the configured information. See sam-

ple programs in the Tracer graphical programming library.

To set up an SCC or DAC profile:

1. In the Active Device View, click the Unit tab. The status information 
for the controller appears.

2. Click the Configuration button. The Configuration dialog box appears 
with the Unit tab displayed (Figure 17 on page 20).

3. Click to select the Activate Profile check box.

4. Click the SCC option to provide a network interface following the 
SCC profile or click the DAC option to provide a network interface fol-
lowing the DAC profile.

5. Complete one of the following options:

• Click the SCC or DAC tab to set up the interface. See the follow-
ing sections for more information on configuring the interface.

• Click the Download button to send your changes to the Tracer 
MP580/581 and click Close to close the Configuration dialog box 

Configuring the SCC interface

To set the configuration parameters associated with the SCC profile:

1. In the Active Device View, click the Configuration button. The Config-
uration dialog box appears.

2. Click the SCC tab. The SCC configuration information appears 
(Figure 32).

Note:

This tab is available only when the SCC profile is active in the 
Tracer MP580/581. 
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Figure 32. Device configuration SCC tab

3. Under Units, click the display units option for the SCC profile config-
uration data.

4. Under Default Setpoints, type the heating and cooling default set-
points for the occupied, unoccupied, and standby modes.

5. Under Space, type the CO2 limit and the relative humidity setpoint.

6. In the Damper Minimum Position field, type the lowest position you 
want the outdoor air damper to reach.

7. In the Occupied Bypass Timer field, type the amount of time you 
want the controller to remain in occupied bypass mode. 

When a user overrides the controller to occupied bypass mode, it stays 
in this mode for the time specified here.

8. Click the Download button to send your changes to the Tracer 
MP580/581.

9. Click Close to close the Configuration dialog box.

Configuring the DAC interface

To set the configuration parameters associated with the DAC profile:

Note:

You need to address only those fields that are used in the pro-
gram to control the air-handling unit.
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1. In the Active Device View, click the Configuration button. The Config-
uration dialog box appears.

2. Click the DAC tab. The DAC configuration information appears 
(Figure 33).

Figure 33. Device configuration DAC tab

3. Under Units, click the display units option for the DAC profile config-
uration data.

4. Under Default Setpoints, type the heating and cooling default set-
points for the occupied, unoccupied, and standby modes.

5. Under Discharge Air Setpoints, type the discharge air setpoints for 
the DAC profile.

6. Under Static Pressure, type the duct static pressure setpoint and 
limit and the building static pressure setpoint.

Note:

This tab is available only when the DAC profile is active in the 
Tracer MP580/581. 

Note:

You need to address only those fields that are used in the pro-
gram to control the air-handling unit.
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7. Under Air Temperature, type the mixed air temperature low-limit 
setpoint and the outdoor air temperature setpoint.

8. In the Occupied Bypass Timer field, type the amount of time you 
want the controller to remain in occupied bypass mode.

When a user overrides the controller to occupied bypass mode, it stays 
in this mode for the time specified here.

9. Click the Download button to send your changes to the Tracer 
MP580/581. Click Close to close the Configuration dialog box.

Configuration reports
After configuring the Tracer MP580/581 controller, you can save and 
print reports that include the configuration parameters set up for the con-
troller. These reports can be used to verify the appropriate specifications 
for the consulting engineer or to document the specifications for the 
customer.

Saving configuration reports

To save a configuration report:

1. In the Active Device View, click the Reports button. The Report Selec-
tion dialog box appears.

2. Click to select the check boxes for the configuration items you want in 
the report.

3. Click the Save to File button. A Save As dialog box appears.

4. Select or enter a file name for the data that will be saved. Click OK. 
The file is saved as a comma-separated values (CSV) file. Use a 
spreadsheet program, such as Microsoft Excel, to view the report.

Printing configuration reports

To print a configuration report:

1. In the Active Device View, click the Reports button. The Report Selec-
tion dialog box appears.

2. Click to select the check boxes for the configuration items you want in 
the report.

3. Click the Print button. The Print dialog box appears.

4. Select the appropriate printer and set the print properties. Click OK.

5. Click OK. The report prints.
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Memory reset
If you have security privileges to do so, you can reset the memory of the 
controller. Resetting the memory removes all data in the controller data-
base and returns the controller settings back to factory defaults. 

To reset memory:

1. In the Active Device View, click the Configuration button. The Config-
uration dialog box appears.

2. From the Devices menu, choose Reset Memory. The Reset Memory 
dialog appears. (If the Security Logon dialog box appears, log on.)

3. Click the Yes button. The Reset Memory dialog box closes, and the 
Rover service tool loses communication with the controller.

4. Click Close to close the Configuration dialog box. 

5. From the Group menu, choose Discover to re-establish communica-
tion between the Rover service tool and the controller.

Unlocking controller for flash download
The Tracer MP580/581 controller is a host-based controller. Host-based 
controllers with flash memory can receive a flash download of new firm-
ware. If security is enabled and you have security privileges, you can 
unlock the controller to enable flash downloading. If security is disabled 
for all users, unlocking is not required. 

To unlock the controller:

1. In the Active Device View, click the Configuration button. The Config-
uration dialog box appears.

2. From the Devices menu, choose Unlock Device. (If the Security Logon 
dialog box appears, log on.)

3. Backup files as necessary.

4. For details regarding flash downloading (refer to “Performing a Flash 
Download” in the Rover Operation and Programming guide, EMTX-
SVX01C-EN).

Note:

This features applies to only Tracer MP580/581 Firmware Revi-
sion 2 or higher. Follow the procedure for “Viewing Comm5 
parameters” on page 13 to view your current revision number.

Note:

Unlocking the controller applies to only Tracer MP580/581 
Firmware Revision 2 or higher. If you have a Revision 1.xx con-
troller, you can perform a flash download without unlocking the 
controller. Follow the procedure for “Viewing Comm5 parame-
ters” on page 13 to view your current revision number.
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Using the Schedule 

application

The Tracer MP580/581 plug-in includes a schedule application that you 
can use to set up a local schedule. The local schedule functions only when 
a non-portable operator display is connected the controller. The local 
schedule is used only if Tracer Summit is not communicating on the link. 
Use the information in this chapter to set up the local daily schedule and 
exceptions for the Tracer MP580/581 controller.

Viewing the status of the time-of-day 

schedule
To view the status of the time-of-day schedule:

In the Active Device View, click the Application tab. The status of the 
Tracer MP580/581 applications appears. The current mode of the 
schedule and the current day and time of the controller appear under 
Schedule (Figure 34).

Figure 34. Time of day schedule status
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Setting up the daily schedule
To set up the daily schedule:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears (Figure 35).

Figure 35. Daily Schedule tab in Schedule application

2. Under Display, click the option for the type of schedule you want. The 
daily schedule table changes to include the appropriate number of col-
umns.

If you want to use the same schedule for Monday through Friday, click 
the Sunday, Monday through Friday, and Saturday option. Click the 
Seven Day Schedule option if you want to specify a different schedule 
for each day of the week.

3. Under Display, click to select the Enable Second Start/Stop Events 
check box if you want to include a second set of start and stop times to 
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the daily schedules. Another set of Start and Stop rows appears in the 
daily schedule table.

Figure 36. Start and stop time examples

4. In the daily schedule table, click in the cell for the day-of-the-week 
start time.

5. Type the time you want the occupancy to start.

Note:

The controller does not check event order. It always implements 
the last commanded mode. This implies that you could have two 
starts or two stops in a row in a single day. Figure 36 illustrates 
some examples of event orders. For Example 3, assume that the 
previous day ended with a start event. Example 4 shows the 
schedule output in the case of two start and stop events in a 
row. The second event of the same type is ignored. 
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6. Repeat steps 4 and 5 until you have all the start and stop times you 
want entered.

If you want no occupied time for a day, enter only a stop time for that 
day.

7. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Clearing a start or stop time

To clear a start or stop time:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. In the daily schedule table, select the start or stop time you want to 
clear.

3. Press the Delete key.

4. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Clearing the event times for a day

If event start and stop times have been entered for a particular day and 
you do not want any events scheduled for that day, clear the event times 
for that day.

To clear the event times for a day:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. In the daily schedule table, click the name of the day you want to 
clear.

3. Click the Clear Daily Schedule button. The start and stop times for 
that day are cleared.

4. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.
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Clearing all daily event times

To remove all daily event times at once:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Clear All Daily Schedules button. All start and stop times 
are cleared from the table.

3. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Copying a daily schedule

To speed set up and editing time, enter the start and stop times for one 
day and then copy that schedule to another day.

To copy a daily schedule:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Copy Daily Schedule button. The Copy Daily Schedule dia-
log box appears (Figure 37).

Figure 37. Copy Daily Schedule dialog box

3. In the Copy From list, click the day you want to copy the schedule 
from.

4. In the Copy To list, click the day you want to copy the schedule to.

5. Click the Copy button. A message appears stating that the schedule 
has been copied.

6. Click OK. The new schedule appears in the table.

7. Copy additional schedules or click Close to close the Copy Daily 
Schedule dialog box.

8. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.
CNT-SVP01C-EN 53



Chapter 4 Using the Schedule application
Setting up the exception schedule
An exception is a period of time that does not follow the regular sched-
ule—for example, a holiday or an unusual work day or event. You can 
add, edit, or clear exceptions to the schedule. 

Adding an exception

You can set up a maximum of 20 exceptions.

To add an exception:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Exception Schedule tab (Figure 38 on page 54).

Figure 38. Exception Schedule

3. Click the Add Exception button. A blank exception row appears in the 
table.

Note:

An exception is cleared automatically once the current date is 
past the exception stop date.
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4. Type a new name, such as New Years 2002.

5. Click the start date.

6. Highlight the text and type a new date or click the down arrow to 
select from the calendar.

7. Enter the stop date, start time, and stop time. 

If you want an exception event to have no occupied time, delete the 
start time and enter only a stop time, such as 12:00 A.M. The request 
remains unoccupied until the next start time in the schedule.

8. If you want a second start and stop time, click to select the Enable 
Second Start/Stop Event check box.

The controller does not check event order. It always implements the 
last commanded mode. This implies that you could have two starts or 
two stops in a row in a single day. Figure 36 on page 51 illustrates 
some examples of event orders.

9. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Clearing an exception

Clear an exception if you want to follow the normal schedule rather than 
a previously entered exception.

To clear an exception:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Exception Schedule tab.

3. Click in the row of the exception that you want to clear (Figure 39).

Note:

Click and drag the column splitters to adjust the width of the 
columns in the table.
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Figure 39. Exception row selected

4. Click the Clear Exception button. The exception is removed from the 
table.

5. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Editing an exception

To change existing exceptions to the schedule:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Exception Schedule tab.

3. Click the item in the row of the exception you want to change.

4. Highlight the text and type a value.

5. If you want a second start and stop time, click to select the Enable 
Second Start/Stop Event check box.
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6. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.

Setting up occupancy inputs
The effective occupancy of the Tracer MP580/581 controller can be 
changed also by other inputs. A timed override is initiated by pressing the 
ON button on a Trane zone sensor. A timed override request changes the 
occupancy mode from unoccupied to occupied bypass. The controller 
remains in occupied-bypass mode until the bypass timer times out or the 
CANCEL button on the sensor is pressed.

To set up occupancy inputs:

1. In the Active Device View, click the Schedule button. The Schedule 
dialog box appears.

2. Click the Occupancy Inputs tab (Figure 40 on page 58).

Note:

Although the occupancy input override request affects the occu-
pancy mode of the Tracer MP580/581 controller, programming 
is required for the equipment controlled by the Tracer MP580/
581 to react to this request. See Chapter 8, “Using the Occu-
pancy and PID blocks” for more information.
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Figure 40. Occupancy Inputs tab in Schedule application

3. In the Timed Override Input list, click the universal input you want 
to act as the timed override input for the controller. 

To appear in the list, the input must be configured as a thermistor. 
This input causes the controller to go to the occupied bypass mode. It 
stays in occupied bypass mode for the time set up as the occupied 
bypass timer.

4. In the Occupancy Sensor Input list, click the universal input you 
want to act as the hard-wired occupancy sensor to the controller. 

To appear in the list, the universal input must be configured as a 
binary input. This input controls the controller occupancy to occupied 
or unoccupied depending on the control source for the schedule. See 
Table 2 on page 62 for more information.

5. Complete one of the following options.

• Make more changes.
• Click another tab in the Schedule application.
• Click the Download button to send your changes to the Tracer 

MP580/581 and click Close to close the Schedule dialog box.
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Synchronizing time with Tracer Summit
Time synchronization of the Tracer MP580/581 controller with the Tracer 
Summit building automation system occurs automatically once a day or 
when the controller is powered up. The controller must be successfully 
communicating for the synchronization to occur.

Controlling the occupancy mode of the 

Tracer MP580/581
The occupancy mode of the Tracer MP580/581 controller can be controlled 
by the Schedule application, the operator display, a Rover service tool 
override, and the Tracer Summit system. Because there are several 
sources of control, there is an implied priority table. Table 2 on page 62 is 
a diagram of the priority list. 

The highest priority is given to a request from the operator display or the 
Rover service tool. Both sources have the same priority level. The next 
highest priority is the building automation system (BAS), often the 
Tracer Summit system. The BAS request is initiated as long as all over-
rides from the operator display or Rover service tool have been released. 
Third on the list of priorities is the Tracer MP580/581 Schedule applica-
tion local schedule. 

The local schedule is used only if valid times are entered in the schedule 
table, and one of the following criteria is met. 

• The controller is connected to an operator display (non-portable).
• Fifteen minutes have passed since the BAS lost communications.
• No overrides are present from the operator display or the Rover ser-

vice tool.

If there are no times entered in the schedule table and no schedule 
request is available, the fourth and fifth items in the priority list are the 
communicated occupancy sensor and the local occupancy sensor, respec-
tively. The default to occupied is the lowest on the list of priorities. If 
nothing is controlling the device, the controller remains in occupied mode.

Manual command

If an occupancy override is requested, the occupancy information is com-
municated to the Tracer MP580/581 from the variable nviOccManCmd or 
as an override from the operator display or Rover service tool. This man-
ual command takes priority over any other occupancy request. If the oper-
ator display is unplugged with an active override, the occupancy request 
remains in the override state. There is no time out, just as with nviOcc-
ManCmd. 

If power is lost, the operator display override value is stored in EEPROM 
and is restored when power returns. This is not the same as nviOcc-
ManCmd. The value of nviOccManCmd is lost when power is lost and is 
Null when power returns.
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For more information about the manual command request priority, see 
Table 2 on page 62. For more information about network variable inputs, 
see Chapter 10, “Network variable bindings.”

Time schedule

Building automation systems normally communicate an occupancy 
request using the occupancy schedule input. The controller receives the 
communicated occupancy schedule from the network variable input 
nviOccSchedule. An occupancy schedule may also be communicated 
locally through the Schedule application. The local schedule could be from 
the week-day schedule or the exception schedule. The occupancy request 
from nviOccSchedule, sent from a BAS, takes priority over the local 
schedule. 

For more information about the time schedule request priority, see 
Table 2 on page 62. For more information about network variable inputs, 
see Chapter 10, “Network variable bindings.”

Occupancy sensor

Some occupancy sensors may be equipped with the ability to communi-
cate an occupancy mode to the controller. In such sensors, network vari-
able input nviOccSensor is used to communicate occupancy to the 
controller. The controller must be using the SCC profile to use this vari-
able. 

For more information about an occupancy sensor request priority, see 
Table 2 on page 62. For more information about network variable inputs, 
see Chapter 10, “Network variable bindings.”

Occupancy binary input

A binary input on the controller can be used as an occupancy input if it is 
set up on the Occupancy Inputs tab in the Schedule application. For 
stand-alone controllers (any unit not receiving a communicated occu-
pancy request, typically from a building automation system), the occu-
pancy binary input determines the occupancy of the unit based on the 
hard-wired signal. Normally, the signal is hard-wired to a binary switch 
or time clock.

For controllers that receive a communicated occupancy request from a 
building automation system, the hard-wired occupancy binary input is 
used with a communicated occupancy request to place the controller in 
either occupied mode or occupied standby mode.

If both a hard-wired input and a communicated input exist, the communi-
cated input is used. For more information about occupancy binary input 
request priority, see Table 2 on page 62.
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Bypass timer

The bypass timer is set to the value in the Occupied Bypass Timer field 
every time the controller receives one of the following messages:

• nviOccManCmd = bypass
• Operator display override = bypass
• Timed override ON request from the local zone sensor (The zone sen-

sor ON button is pushed and released within 5 seconds.)

After the bypass timer is set to the value in the Occupied Bypass Timer 
field, it counts down to zero. The bypass timer is cleared every time the 
controller receives one of the following messages:

• nviOccManCmd = occupied, unoccupied, standby, or null
• Operator display override = occupied, standby, or null
• Timed override CANCEL request from the local zone sensor (The 

zone sensor CANCEL button is pushed and released within 25 sec-
onds.)

To disable the bypass timer, type 0 (zero) in the Occupied Bypass Timer 
field. This effectively disables the zone-sensor timed-override ON func-
tion, the operator-display schedule override-bypass enumeration, and the 
nviOccManCmd-bypass enumeration.

Table 2 shows the occupancy result of the hard-wired input, network 
inputs, or local schedule. The columns marked with a dash (—) represent 
inputs that are not considered in the occupancy arbitration. 

Note:

Although the bypass request affects the occupancy mode of the 
Tracer MP580/581 controller, programming is required for the 
equipment controlled by the Tracer MP580/581 to react to this 
request. See Chapter 8, “Using the Occupancy and PID blocks” 
for more information.
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Table 2. Effective occupancy arbitration for Tracer MP580/581 with operator display

Manual 
override1 
(nviOccMan
Cmd)

Commun-
icated 
schedule 
(nviOcc
Schedule)

Local 
schedule

Occupancy 
sensor 
(nviOcc
Sensor2) 

Local 
occupancy 
binary input

Bypass 
timer3

Result 
(nvoEffect

Occup)

Occupied — — — — — Occupied

Unoccupied — — — — zero Unoccupied

not zero Bypass

Bypass Occupied — — — — Occupied

Unoccupied — — — zero Unoccupied

not zero Bypass

Standby — — — zero Standby

not zero Bypass

Null Occupied — — — Occupied

Unoccupied — — zero Unoccupied

not zero Bypass

Null Occupied — — Occupied

Unoccupied — zero Unoccupied

not zero Bypass

Null Occupied — Occupied

Unoccupied zero Unoccupied

not zero Bypass

Not present — Occupied

Standby — — — — zero Standby

not zero Bypass
1 This value is the last enumeration received. It can come from either the nviOccManCmd network variable or the operator dis-

play schedule override.
2 The variable nviOccSensor is used with the SCC profile only. Refer to the Null rows in this column for the DAC profile.
3 This value represents whether or not the bypass timer is at zero or not. When a bypass request is made, the timer is set to the 

value specified in the Occupied Bypass Timer field, and it begins to count down. While it is counting down, the value is not 
zero. When the count down is complete, the value is zero.
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Null Occupied — Occupied — — Occupied

Unoccupied — zero Standby

not zero Bypass

Null Occupied — Occupied

Unoccupied zero Standby

not zero Bypass

Not present — Occupied

Unoccupied — — — zero Unoccupied

not zero Bypass

Standby — — — zero Standby

not zero Bypass

Null Occupied Occupied — — Occupied

Unoccupied — zero Standby

not zero Bypass

Null Occupied — Occupied

Unoccupied zero Standby

not zero Bypass

Not present — Occupied

Unoccupied — — zero Unoccupied

not zero Bypass

Null Occupied — — Occupied

Unoccupied — zero Unoccupied

not zero Bypass

Null Occupied — Occupied

Unoccupied zero Unoccupied

not zero Bypass

Not present — Occupied

Table 2. Effective occupancy arbitration for Tracer MP580/581 with operator display (Continued)

Manual 
override1 
(nviOccMan
Cmd)

Commun-
icated 
schedule 
(nviOcc
Schedule)

Local 
schedule

Occupancy 
sensor 
(nviOcc
Sensor2) 

Local 
occupancy 
binary input

Bypass 
timer3

Result 
(nvoEffect

Occup)

1 This value is the last enumeration received. It can come from either the nviOccManCmd network variable or the operator dis-
play schedule override.

2 The variable nviOccSensor is used with the SCC profile only. Refer to the Null rows in this column for the DAC profile.
3 This value represents whether or not the bypass timer is at zero or not. When a bypass request is made, the timer is set to the 

value specified in the Occupied Bypass Timer field, and it begins to count down. While it is counting down, the value is not 
zero. When the count down is complete, the value is zero.
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Chapter 5

Using the Calculations 

application

If there is a Tracer Summit system on the active link, use its totalization 
application to totalize pulse accumulations. If there is no Tracer Summit 
system on the active link, the Tracer MP580/581 plug-in includes the Cal-
culations application that you can use to totalize pulse accumulations. 

This application is easy to set up and apply to electrical monitoring, fluid 
flow, and other metering and monitoring functions. It can also be used to 
calculate runtime and starts for equipment. You do not have to do custom 
programming to calculate runtime. You can run up to six calculations. 
Use this application only for non-billing purposes.

Viewing the status of a calculation
In the Rover service tool, view the status of a calculation, including its 
name, type, current value, and units. You can also view the accumulated 
values for the calculation.

To view the status of a calculation:

In the Active Device View, click the Application tab. The status of the 
Tracer MP580/581 applications appears (Figure 41 on page 66).
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Figure 41. Calculations application status

Setting up a calculation
Set up the calculation name, input type, input, conversion factor, and 
units. Use the conversion factor and the units to make the value dis-
played in the Rover service tool more meaningful.

When you choose the input type, you also choose the calculation type. If 
an analog or pulse input is chosen, a totalization is performed. The calcu-
lation output is the sum of the pulse input values multiplied by the con-
version factor. If a binary input type is chosen, the Tracer MP580/581 
calculates run hours and starts. The output is incremented every minute 
a binary value is true. Starts are incremented every time a binary value 
changes from off to on.

To set up a calculation:

1. In the Active Device View, click the Calculations button. The Calcula-
tions dialog box appears (Figure 42 on page 67).
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Setting up a calculation
Figure 42. Calculations dialog box

2. In the Name list, click the calculation you want to set up. The configu-
ration information for that calculation appears.

3. If you want to change the calculation name, highlight the text and 
type a new name.

4. In the Input Type list, click the type of input you want the calculation 
to use. 

This selection also controls what type of calculation occurs. If you 
select either an analog input or pulse input, the calculation type is a 
totalization. If you choose a binary input, Tracer Summit binary vari-
able, local binary variable, or network variable input, the calculation 
type is total run hours and starts. See Table 3 for a list of the input 
types and their corresponding calculation types and available points. 

Table 3. Input type selections

Input type Calculation type Available points

Analog input Totalization Universal inputs configured as 
Linear (0–20 mA)

Universal inputs configured as 
Linear (0–10 VDC)

Binary input Total run hours/
Starts

Universal inputs configured as 
Binary

Pulse input Totalization Universal inputs configured as 
Pulse
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5. In the Input list, click the input you want to use in the calculation.

6. If the input is not a binary input, type a number in the Conversion 
Factor field. 

This value is used to convert the raw calculation into a more mean-
ingful value. The default value is 1 and is good for many configura-
tions. The conversion factor used here does not affect the value sent to 
the Tracer Summit system. Click the Help button to see a table of 
common conversion factors.

7. In the Units list, click the display units for the calculation output.

8. If you want to reset the current calculation values to zero at a specific 
time or when an event occurs, click to select the Reset Calculation 
check box and go to step 9. If you do not want to reset the calculation, 
go to step 13.

Resetting the calculation moves the current-period value to the last-
period value and sets the today, yesterday, and current-period value to 
zero.

9. Click the option for the time you want the calculation reset.

• If you want the calculation reset at 12:00 A.M. on the day after the 
last day of the month, click the Last Day of Month option and go 
to step 13. The value just before the reset is saved as the last-
period value.

• If you want the calculation reset at 12:00 A.M. the day after a 
defined day of the month, click the Day of Month option and go to 
step 10.

• If you want the calculation reset when a binary point changes 
from off to on, click the Binary Input/Variable option and go to 
step 11.

10. In the Day of Month list, click the day of the month you want the cal-
culation reset and go to step 13. The calculation is reset to zero at 
12:00 A.M. on the day after this day, and the value just before the reset 
is saved as the last-period value.

Tracer Summit 
binary variable

Total run hours/
Starts

All Tracer Summit binary vari-
ables (1–30)

Local binary 
variable

Total run hours/
Starts

All local binary variables (1–120)

Network variable 
(nviSwitch)

Total run hours/
Starts

All generic network variables 
nivSwitch01 to nviSwitch40

Table 3. Input type selections (Continued)

Input type Calculation type Available points
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Clearing a calculation
11. In the Binary Type list, click the type of binary point you want to con-
trol the calculation reset. See Table 4 for a list of the binary points 
available for each input type.

The calculation restarts when the binary point changes back to off. 
The value just before the reset is saved as the last-period value.

12. In the Binary Input/Variable list, click the binary input or variable 
you want to control the calculation reset. The calculation is reset to 
zero when this binary point changes from off to on, and the value just 
before the reset is saved as the last-period value.

13. Complete one of the following options:

• Click another calculation name in the Name list to edit another 
calculation.

• Click the Download button to download your changes to the 
Tracer MP580/581 and click Close to close the Calculations dialog 
box.

Clearing a calculation
Use the Clear Calculation button to manually set all calculation values 
(today, current period, yesterday, and last period) to zero.

To clear a calculation:

1. In the Active Device view, click the Application tab. The status of the 
applications appears.

2. In the Calculations table, click the name of the calculation you want 
to reset.

3. Click the Clear Calculation button. A message appears asking if you 
want to set the data to zero.

4. Click Yes. All the calculation values are set to zero.

5. Complete one of the following options:

• Click another calculation name in the Name list to edit another 
calculation.

• Click the Download button to download your changes to the 
Tracer MP580/581 and click Close to close the Calculations dialog 
box.

Table 4. Binary input types

Input type Available points

Binary input Universal inputs configured as binary

Tracer Summit binary variable All Tracer Summit binary variables (1–30)

Local binary variables All local binary variables (1–120)

Network variable All generic network variables nviSwitch01 
to nviSwitch40
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Chapter 6

Graphical programming 

overview

Use the Tracer graphical programming (TGP) editor to create and modify 
programs for the Tracer MP580/581 controller. The programs are stored 
in the controller with their graphical representations and can be 
uploaded and modified or re-used.

This guide includes basic instructions to introduce you to the editor. The 
TGP editor includes sample programs for common applications, such as 
cooling towers and air handlers. For a step-by-step tutorial on how to use 
the TGP editor, see the Tracer Graphical Programming applications 
guide (CNT-APG001-EN).

Opening the TGP editor
To open the TGP editor:

In the Active Device View, click the Program Editor button. The TGP 
editor appears with a blank program in the design space (Figure 43 
on page 72). 
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Figure 43. TGP editor running in Rover service tool

TGP editor
The TGP editor screen includes the design space, output display, blocks, 
menu bar, toolbars, and shortcut menus.

Design space

The design space is the area in which you can draw graphical programs.

Output display

The output display is the area in which results from building a graphical 
program appear.

To show or hide the output display:

Design
space

Menu bar

Toolbars

Output
window

Title bar

Splitter bar
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TGP editor
From the View menu, choose Output Display. If Output Display is 
checked, the output display is shown.

Blocks

Graphical programming blocks are the fundamental objects used to write 
a program in the TGP editor. Each block serves a specific purpose. Con-
necting these blocks in a given arrangement determines how the program 
behaves. A program consists of a combination of graphical programming 
blocks connected to perform a logical task.

Figure 44 illustrates the basic structure of a graphical programming 
block. The connection points on the left side of the block are called input 
ports. Input ports pass data into the block. Connections on the right side 
of the block are called output ports. Output ports pass data out of the 
block.

Figure 44. Block structure

Menu bar

The menu bar at the top of the TGP editor contains drop-down menus for 
working with TGP programs. Use the File menu to open new and existing 
program files as well as to save programs and set program properties. 
Use the Edit menu to undo and redo the last action made in the editor. 
This menu also includes options for cutting, copying, pasting, and delet-
ing program elements.

Use the View menu to set up the editor window. The Blocks menu 
includes options for placing blocks in the design space. Use the Alignment 
menu to align blocks in the design space. The Tools menu includes options 
for working with your program. Use the Help menu to access the exten-
sive TGP online Help and to find more information about the TGP editor.

Toolbars

The TGP editor includes toolbars that provide buttons you can press to 
complete common tasks.

Note:

If you still cannot see the output display, the splitter bar may be 
too low. To move it up, make sure the status bar is visible and 
click under the design space. Move the splitter bar up.

Note:

For further information on specific graphical programming 
blocks, see the blocks reference in the online Help.
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Standard toolbar

Use the Standard toolbar buttons (Figure 45) to open a new or existing 
program file or to save a file. Click one of the edit buttons to cut, copy, 
paste, or delete a block or group of blocks. You can undo or redo the last 
action completed in the editor, add a wired or wireless connection, or print 
the program. Click the Help button and then click on a block in the design 
space to get information about that block.

Figure 45. Standard toolbar

Alignment toolbar

Select the blocks in the design space you want to align and click an align-
ment button (Figure 46) to align the blocks in the design space. The last 
block selected controls the alignment.

Figure 46. Alignment toolbar

New

Open

Save

Print

Cut

Copy

Paste

Undo

Redo

Delete

Select

Wire

Comment

Wireless 
Connection

Help

Left Alignment

Right Alignment

Bottom Alignment

Top AlignmentTop Alignment
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Block toolbars

Use each of the following toolbars to add various blocks to your TGP pro-
gram (Figure 47). For more information about each block, see the blocks 
reference in the online Help. The blocks are subdivided into eight catego-
ries. These categories are displayed in separate toolbars.

Figure 47. Block toolbars

Math toolbar

Input/Output toolbar 

Logic toolbar

Compare toolbar

Calculation toolbar

Add

Subtract

Multiply

Divide

Average

Minimum

Maximum

Absolute Value

Square Root

Input
(Hardware)

Output 
(Hardware)

Network 
Variable Output

Network 
Variable Input

Network 
Configuration Input

Constant

Time

Date

Tracer 
Request

Occupancy

Output Status

Comm Status
Calculation 
Status

Variable

And

Or

Not

Xor

Greater
Than

Greater Than 
or Equal

Less Than

Less Than 
or Equal

Equal

Not Equal

Between

PID

Enthalpy

Dewpoint

Wet-Bulb

Air Flow

Reset

Air Flow
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Function toolbar

Time Delay toolbar

Test toolbar

Program toolbar

Use the Program toolbar to build programs and to control the programs 
on the Tracer MP580/581 controller (Figure 48).

Figure 48. Program toolbar

Showing or hiding toolbars

You can show or hide each toolbar in the TGP editor window. You can also 
move each toolbar in the window by clicking on the title bar of the toolbar 
and dragging it to a new position.

To show or hide a toolbar:

From the View menu, choose Toolbars. From the Toolbars menu, 
choose the toolbar you want to view or hide. If a check mark is next to 
the toolbar name, that toolbar is shown in the window.

Deadband

Switch

Limit

DeEnumerator

Latch

Delay on Start

Delay on Stop

Feedback Alarm

Fail

On

Cancel

Build

Upload from 
MP580

New - Download 
to MP580

Replace Existing - 
Download to MP580

Delete Program 
from MP580
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Short cut menus

To view a shortcut menu, use your right mouse button to click any block 
or port in the design space (Figure 49). Shortcut menus contain common 
commands you can use on the item you clicked. For example, right-click 
an input (hardware) block in the design space and choose Properties from 
the shortcut menu to edit the properties of the block.

Figure 49. Shortcut menu

Keyboard short cuts
Use keyboard short cuts (Table 5) in the TGP editor to work with program 
files and blocks.

Table 5. Keyboard short cuts

Category Function Key stroke

File New Ctrl+N

Open Ctrl+O

Save Ctrl+S

Print Ctrl+P

Edit Undo Ctrl+Z

Redo Ctrl+Y

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Delete

Blocks Block (pop-up menu) Ctrl+B

Comment Ctrl+T

Wire Ctrl+W

Wireless Ctrl+L

Program Build F7

Tools Start Debug/Start 
Simulation

F11

Run F5

Exit Debug/Exit 
Simulation

Shift+F11
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Chapter 7

Creating a graphical program

This chapter introduces the basics of Tracer graphical programming 
(TGP). Graphical programming consists of drawing a picture that repre-
sents data and logic.

Before you start to write a program, configure the inputs and outputs. For 
more information on configuring the inputs and outputs, see Chapter 3, 
“Configuring the Tracer MP580/581.” For more information on setting up 
the wiring, see the Tracer MP581 Programmable Controller Hardware 
Installation guide (CNT-SVN01B-EN). 

Creating a new program
When the editor opens, a new, blank program appears. If a program is 
already open, or you want to open a new program, save the current pro-
gram and then choose New from the File menu. A blank program appears 
in the design space (Figure 43 on page 72).

Opening an existing program
To open an existing program:

1. From the File menu, choose Open. The Open dialog box appears.

2. Select the program you want to open.

3. Click Open. The program opens in the design space (Figure 50).

Figure 50. Equipment room exhaust fan program

Note:

Only one program can be open in the TGP editor at a time.
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Editing program properties
The next step in writing a graphical program is to give the program a 
name and define some basic properties of the program. The properties of 
a program define how the program behaves. For example, Run Frequency 
is a property that defines how often the program executes. It is good prac-
tice to set the program properties before you begin to write a new pro-
gram, but you can edit the properties at any time by opening the Program 
Properties dialog box.

To select the appropriate method of program execution, ask yourself the 
following questions:

• Is the program required to run at regular time intervals? If so, click 
the Run Frequency option. Then specify the time interval in hours, 
minutes, and seconds.

• Is the program required to run on demand? If so, use the Event Trig-
ger option to provide the program with a reference to a universal 
input configured as a binary input or to a binary variable. When the 
binary input or variable changes state, the program runs.

• Is the program required to run only when the Tracer MP580/581 pow-
ers on? In this case, click the Start-up option.

To edit program properties:

1. From the File menu, choose Program Properties. The Program Prop-
erties dialog box appears (Figure 51 on page 81).
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Figure 51. Program Properties dialog box

2. In the Program Name field, type a name for your program.

The name may be up to 32 characters in length. Do not use spaces or 
special characters except for an underscore in program names.

3. Type your name, project name, and phone number in the appropriate 
fields.

This information appears on the printout of the program.

4. Under Configuration, click one of the Run Frequency options.

5. In the Number of Pages field, type the number of pages you need to 
draw your program.

The allowable range is one to five pages. You can always change the 
number if you find that you have too few or too many pages.

6. In the Program Description field, type a description of your program.

7. Click OK.

Note:

When choosing Run Frequency, keep in mind that universal 
input status from expansion modules is updated every 
2 seconds.
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Setting page width and size
The page size and layout you choose impacts the design space. For exam-
ple, if you want to have a wider and shorter space, choose the landscape 
option. If you want to print your programs on 11 × 17 in. paper, choose 
that option.

To set page width and size:

1. From the File menu, choose Page Setup. The Page Setup dialog box 
appears.

2. Set the paper size, orientation, and margins. These settings apply to 
the TGP editor design space. 

3. Click the Print Setup button. The Print Setup dialog box appears. 

4. Set the paper size and orientation to implement these settings on 
paper when the program is printed.

5. Click OK. The Print Setup dialog box closes.

6. Click OK. The Page Setup dialog box closes, and the design space 
changes to the new setting.

Adding a block
To add a block:

1. From the Blocks menu, choose the type of block you want to add. See 
Figure 52 for an example. The cursor changes to a cross-hair (;) when 
over the design space.

Figure 52. Choosing Input (Hardware) from the Input/Output Blocks 

menu
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2. Click in the design space to place the block. The block appears at the 
cursor location in the design space (Figure 53).

Figure 53. Input (Hardware) block

Editing block properties
A block is an object. In the TGP editor, you can edit the properties for 
objects, such as programs and blocks, by using their properties dialog 
boxes. Set the properties of each block as you place it in the program. This 
is especially important for blocks that can be set as analog or binary, 
because the connections between blocks are dependent on the data type, 
analog or binary.

To edit block properties:

1. Click on the block to select it. The block is outlined in yellow.

2. From the Edit menu, choose Properties. The properties dialog box for 
the block appears (Figure 54).

Figure 54. Input Properties dialog box

3. Set the properties for the block.

4. Click OK.

Note:

The properties dialog boxes for each block vary considerably 
depending on the options available for that block. Some blocks 
have no editable properties.
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Adding a comment
Use comments to make notes in your program, to annotate blocks, or to 
describe logic.

To add a comment:

1. From the Blocks menu, choose Comment and click in the design space 
to place the Comment block. The Comment dialog box appears.

2. Type the text you want to appear as a comment.

3. Click OK. The comment appears in the design space (Figure 55).

Figure 55. Comments added to describe the Constant block and the Deadband block

Arranging blocks
The graphical element of graphical programming is critical. Move blocks 
and use the alignment options to arrange your blocks and design your 
programs.

Moving blocks

To move blocks:

1. Press and hold the left mouse button on a block and then move the 
cursor (click and drag) to move the block to a new position in the 
design space. The block appears in the new location.

2. To select two or more blocks, press the Ctrl key while clicking to select 
blocks. The selected blocks are outlined in yellow.

3. Click and drag the selected blocks to a new position in the design 
space. The blocks appear in the new location.

Comments

Note:

You can also use a rubber-band selection to select more than 
one block. Click in the design space and drag the cursor so that 
the white line surrounds the blocks you want to select.
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Deleting a block
Aligning blocks

To align blocks:

1. Select two or more blocks. The last block selected is the controlling 
block, so all of the selected blocks align according to the position of the 
last block selected. The selected blocks are outlined in yellow.

2. From the Alignment menu, choose the alignment you want. The 
blocks align according to the selection.

Deleting a block
To delete a block:

1. Click on the block. The block is outlined in yellow.

2. From the Edit menu, choose Delete. The block and any wires con-
nected to the block are removed from the design space.

Connecting blocks using wired 

connections
To use wired connections to pass data from block to block:

1. From the Blocks menu, choose Wire. The cursor changes to a cross-
hair (;) in the design space.

2. Hold the cursor over the output port of a block. The cursor changes 
from a simple cross-hair to a cross-hair with a square (Figure 56). 
This change in the cursor indicates that a connection may be made.

Figure 56. Cursor in wire mode over a valid connection

Note:

To delete a block, you can also select the block and then press 
the Delete key.

Note:

You may start wires on any block-input or -output port or on an 
existing wire. You cannot end a connection on a wire.
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3. Click on the output port of a block. A solid or dotted line appears 
between the connection point and the cursor.

Figure 57. Cursor in wire mode on an invalid connection

4. Click in an empty area of the design space to add a turn to the wire.

5. Move the cursor and click on an input port of a block. The wired con-
nection is complete (Figure 58).

Figure 58. Analog wired connection

Connecting blocks using wireless 

connections
Use wireless connections to pass data from block to block when wired con-
nections are impractical. In general, it is good programming practice to 
use an input in a program only once. By doing so, you will have an easier 
time debugging your program. By using the wireless connection, you can 
also prevent long and overlapping wired connections that are difficult to 
follow.

Figure 59 on page 87 is a sample program without wireless connections. 
Figure 60 on page 88 is the same program with two wireless connections 
added.

Note:

A solid wire between blocks represents analog data being 
passed. A dotted wire between blocks represents binary data 
being passed. An analog-output port cannot be connected to a 
binary-input port, and a binary-output port cannot be con-
nected to an analog-input port. Figure 57 shows the cursor that 
is displayed over an invalid connection.

Analog 
wire

Binary 
wire
86 CNT-SVP01C-EN



Connecting blocks using wireless connections
Figure 59. Program without wireless connections
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Figure 60. Program with wireless connections

To connect blocks using a wireless connection:

1. From the Blocks menu, choose Wireless. The cursor changes to a 
cross-hair (;) in the design space.

2. Click in the design space to place a wireless block. The Wireless Con-
nection Properties dialog box appears (Figure 61 on page 89).
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Connecting blocks using wireless connections
Figure 61. Creating wireless connection block

3. Under Block, click the Write (Create) option to create a new wireless 
connection block.

4. Under Create, click the option for the type of connection you want to 
make: analog or binary.

5. In the Name field, type a name for the block.

The name may be up to 16 characters in length. Spaces are not 
allowed.

6. Click OK. The Wireless write block appears in the design space.

7. Connect the Wireless write block with a wired connection to the block 
with the value you want to write to the wireless block (Figure 62).

Figure 62. Wireless write connection

8. From the Blocks menu, choose Wireless. and click in the design space 
to place a wireless block. The Wireless Connection Properties dialog 
box appears (Figure 63 on page 90).
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Figure 63. Using wireless connection block

9. Under Block, click the Read (Use) option to use a new wireless con-
nection block.

10. Under Use, in the Name list, click the wireless connection you want to 
use.

11. Click OK. The Wireless read block appears in the design space.

12. Connect the Wireless read block with a wired connection to the block 
to which you want to pass the wireless value. The wireless connection 
is complete (Figure 64).

Figure 64. Wireless read connection
90 CNT-SVP01C-EN



Refreshing the TGP editor
Refreshing the TGP editor
After making changes to the controller configuration, use the refresh 
function to update the TGP editor. For example, if you are writing a pro-
gram and you realize that you need to set up an analog variable, go to the 
Rover application to set up the variable. Then return to the TGP editor 
and refresh the analog variables to implement the variable you just con-
figured.

To refresh the TGP editor:

1. From the View menu, choose Refresh.

2. From the Refresh menu, choose the set of data you want to refresh or 
choose All. The configuration data uploads to the editor.

Saving a program
To save a program:

1. From the File menu, choose Save. The Save As dialog box appears.

2. In the File name field, type a name for your program.

3. Click Save. The graphical program file is saved. 

All files are saved with a file extension of *.tgp, which denotes the file 
as a Tracer graphical program.

Printing a program
To print a hard copy of a program:

1. From the File menu, choose Print. The Print dialog box appears.

2. Select the printer and set the print range and the number of copies.

3. Click the Properties button to select the paper size and orientation.

4. Click OK. The graphical program is printed.

Closing a program
To close a program, you must open a new or existing program or exit the 
TGP editor. To exit the TGP editor:

From the File menu, choose Exit. The program and the TGP editor 
close.

Note:

To see what your program will look like printed on paper, 
choose Print Preview from the File menu.
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Chapter 8

Using the Occupancy and PID 

blocks

This chapter discusses the Occupancy block and the PID (proportional, 
integral, derivative) block. For more information about specific TGP 
blocks, see the block reference in the online Help.

Using the Occupancy block
The Occupancy block outputs the occupancy request as received by the 
Tracer MP580/581 controller. (For more information about the occupancy 
request arbitration, see Table 2 on page 62.) Use the Occupancy block in 
graphical programming to determine the values and states of the analog 
and binary outputs on the Tracer MP580/581 controller. This section dis-
cusses common uses of the Occupancy block in different program exam-
ples. 

To be useful, the Occupancy block must be used in a TGP program. Four 
examples are shown in this section to aid in program design for two typi-
cal applications of the Occupancy block: fan request and setpoint adjust-
ment. 

The Occupancy block has an enumerated output. The enumerated value 
and mode are shown in Table 6. These values follow the SCC and DAC 
standard.

The following sections contain examples of how the Occupancy block can 
be used in a TGP program. The examples begin as simple as possible and 

Table 6. Occupancy block enumerated values

Output value Mode name Notes

0 Occupied

1 Unoccupied

2 Occupied 
bypass

This mode is the equivalent of a timed over-
ride request. It is considered an occupied 
mode.

3 Occupied 
standby

This mode is meant to be used for a space 
that is currently unoccupied but will be occu-
pied soon. Meeting rooms are a good exam-
ple. Typically, this mode has different 
setpoints than the occupied or unoccupied 
modes.
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become more complex. The program is shown and discussed in each 
example.

Using the Occupancy block to turn on a supply fan

In the example shown in Figure 65, the program takes advantage of the 
fact that the Occupancy block output is an analog value. It uses an Equal 
block to compare the Occupancy block output to a Constant block. If the 
Occupancy block output is equal to zero, the output of the Equal block is 
true, and the Supply Fan Start/Stop binary output is true (on). If the 
Occupancy block output is not equal to zero, the Supply Fan Start/Stop 
binary output is false (off). 

Figure 65. Supply fan on or off with an Equal block and a Constant 

block

The use of the Equal block and a Constant block is acceptable for the pro-
gram in Figure 65. But it can become awkward as you use more of the 
Occupancy block output values. Each value would have to have an associ-
ated Equal and Constant block. Alleviate the awkwardness by using the 
DeEnumerator block shown in Figure 66. 

Figure 66. Supply fan on or off with a DeEnumerator block

The program in Figure 66 completes the same function as the program in 
Figure 65. The DeEnumerator block takes the place of the Equal and 
Constant blocks. For more information about the DeEnumerator block see 
the block reference in online Help in the TGP editor.

Using the Occupancy block to adjust setpoints

The program in Figure 67 on page 95 provides two values, the cooling and 
heating setpoints, to other parts of a TGP program. The DeEnumerator 
block controls which value is passed by using a pair of Switch blocks. For 
more information on how the Switch block works see the block reference 
online Help in the TGP editor.
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Figure 67. Occupied and unoccupied mode setpoint adjustment

The program in Figure 68 on page 96 is a direct extension of the one 
shown in Figure 67. Because it is sending setpoint values based on four 
possible modes, it is more complex than the examples seen previously. 
Each mode controls the cooling and heating setpoints to the values in 
Table 7.

Note:

You could use another Switch block to pick which setpoint is 
used. That Switch block would be controlled by the heating or 
cooling mode.

Table 7. Occupancy mode heating and cooling setpoint values

Mode name Cooling setpoint Heating setpoint

Occupied 74.0°F 71.0°F

Unoccupied 85.0°F 65.0°F

Occupied bypass 74.0°F 71.0°F

Occupied standby 78.0°F 69.0°F
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Figure 68. All occupancy modes setpoint adjustment

The DeEnumerator block turns on the appropriate pair of Switch blocks, 
depending on the Occupancy block output. If a Switch block pair is off, it 
contributes zero to the final cooling and heating setpoint calculation. If a 
Switch block pair is on, it contributes the non-zero values to the final cool-
ing and heating setpoint calculation. 

Note:

The occupied and occupied bypass setpoints are the same. 
Occupied bypass should be considered an occupied mode.
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Using the PID block
A proportional, integral, derivative (PID) loop control is an automatic con-
trol system that calculates how far a measured variable is from its set-
point and controls an output to move the measured variable toward the 
setpoint. The loop performs PID calculations to determine how aggres-
sively to change the output.

In the HVAC industry, PID loops are used to control modulating devices 
such as valves and dampers. Some common applications include:

• Temperature control
• Humidity control
• Duct static pressure control
• Staging applications

For a more in-depth discussion of PID control, see the PID Control in 
Tracer Controllers applications guide (CNT-APG002-EN).

Setting up the PID block properties

To set up the PID block properties:

1. From the Blocks menu, choose Calculation. From the Calculation 
menu, choose PID. 

2. Click in the design space to place the PID block (Figure 69).

Figure 69. PID block

3. Double-click the PID block. The PID Properties dialog box appears 
(Figure 70 on page 98).
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Figure 70. PID Properties dialog box

4. In the PID Name field, type the name of your PID block. 

The name is used to select a PID loop for troubleshooting and plotting 
purposes.

5. Under PID Action, click the action option you want.

The action of a PID loop determines how it reacts to a change in the 
measured variable. A controller using direct action increases the out-
put when the measured variable increases. A controller using reverse 
action decreases the output when the measured variable increases.

6. Under PID Setup, in the Error Deadband field, type the error dead-
band value.

The error deadband prevents the PID output from changing when the 
absolute value of the error is less than the error deadband. The error 
itself is defined as the difference between the setpoint and the mea-
sured variable.
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7. If you want a change in the new PID output to be added to the Feed-
back Input for each PID cycle when the program runs, click to select 
the Allow Feedback Input check box. A Feedback Input port is added 
to the PID block. 

NewOutput = Δoutput + FeedbackInput

If this check box is not selected, the previous PID block output is 
added to the change in the new PID output for each PID cycle.

NewOutput = Δoutput + OldOutput

8. Click to select the Proportional Only check box if you do not want to 
use the integral and derivative contributions of the PID loop.

This is typically used with pneumatic controls or in staging 
applications.

9. Type the Proportional Bias if the PID loop is proportional only.

10. Under PID Frequency, enter the time interval at which you want the 
PID loop to run. 

The PID Frequency defaults to the same frequency as the program. 
You may run a PID loop at the same rate as its parent program or at a 
slower rate. The time interval must be an integer multiple of the pro-
gram run frequency.

11. Under Output, type the maximum and minimum output percent val-
ues for the loop.

12. In the Disable Position field, type the disable position value.

When the Output Enable/Disable port of the PID block receives a 
value of false, the PID loop outputs the disable-position value. Other-
wise, the PID loop outputs its calculated value.

13. In the Fail Safe Position field, type the fail safe value.

When the Fail port of the PID block receives a value of true, the PID 
loop outputs the fail-safe-position value. Otherwise, the PID loop out-
puts its calculated value.

14. Click OK.

Note:

This feature applies to only Tracer MP580/581 Firmware Revi-
sion 2 or higher. Follow the procedure for “Viewing Comm5 
parameters” on page 13 to view your current revision number.
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Incorporating the PID block

Add the necessary intermediate blocks and then make the PID block con-
nections.

To incorporate the PID block:

1. Place a Fail block in the design space and connect it so that it checks 
the measured variable for failure.

2. Place three blocks to serve as the proportional, integral, and deriva-
tive gains for the PID block and connect them to the block. 

These three blocks could be inputs, constants, or variables.

3. Connect a block to the Output Enable/Disable port of the PID block. 

When the PID block receives a true value here, it outputs its calcu-
lated result. When the PID block receives a false value here, it out-
puts its disable-position value.

4. Connect the Fail block to the Fail port of the PID block.

When the PID block receives a false value here, it outputs its calcu-
lated result. When the PID block receives a true value here, it outputs 
its fail-safe-position value.

5. Connect an input block to the Measured Variable port of the PID 
block.

6. Connect a block, typically a constant or variable, to the Setpoint port 
of the PID block.

7. Connect a block, such as an analog output status block or a local ana-
log variable block, to the Feedback Input port of the PID block if you 
cleared the Decouple PID Block Output check box in the PID Proper-
ties dialog box.

8. Connect the PID block to the block you want it to control, typically an 
analog output. See Figure 71 for an example of a PID block in a pro-
gram; see Figure 72 on page 102 for an example of a PID block with 
the Feedback Input port present in the program.
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Figure 71. PID block in program
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Figure 72. PID block with Feedback Input port in program
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Chapter 9

Implementing a graphical 

program

Before downloading a program to the Tracer MP580/581, you must com-
pile the program. When you compile, the TGP editor checks the program 
for errors and prepares it for download. You can upload and download 
compiled programs, and you can view the status of downloaded programs 
in the controller.

Compiling a program
To compile a program:

From the Program menu, choose Build/Compile. The system builds 
and compiles the program. The output window displays the results, 
including any applicable errors.

Downloading a program
To download a program to the Tracer MP580/581 controller:

1. Compile the program you want to download if you have not done so 
already.

2. From the Program menu, choose Download to MP580. The Security 
Logon dialog box appears.

3. Type in your user name and password and click OK.

4. From the Download to MP580 menu, choose one of the following 
options:

• New, if the program is new. The program download begins. Upon 
completion of the download, a message appears stating that the 
program downloaded successfully. Go to step 7.

• Replace Existing, if the program already exists in the controller. 
The Select a Program dialog box appears. Go to step 5.

5. Click the program name you want to replace.

6. Click OK. The program downloads. Upon completion of the download, 
a message appears stating that the program was overwritten success-
fully.

7. Click OK.
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Uploading a program
To upload a program from the Tracer MP580/581 controller:

1. From the Program menu, choose Upload from MP580. The Select a 
Program dialog box appears.

2. Click the program name you want to upload.

3. Click OK. The program uploads and appears in the workspace. A 
message may appear asking you to save changes to the current pro-
gram, if you already had one open.

Deleting a program from the 

Tracer MP580/581
To remove an active program from the Tracer MP580/581 controller:

1. From the Program menu, choose Delete Program from MP580. The 
Select A Program dialog box appears.

2. Click the program name you want to delete.

3. Click OK. A message appears asking if you are sure you want to 
delete the program from the controller.

4. Click Yes. A message appears stating that the program has been 
deleted.

5. Click OK. The program has been removed from the controller. 

Viewing program status
You can view the status of each program downloaded to the Tracer 
MP580/581 controller. The program status includes the program name, 
run frequency, and state. It also displays the remaining memory available 
for programs.

To view program status:

From the Tools menu, choose Program Status. The Program Sum-
mary dialog box appears (Figure 73 on page 105).
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Figure 73. Program Summary dialog box

Debugging a program
Debug a program to troubleshoot problems in the program. Debugging is 
performed online. 

To debug a program:

1. Compile and download the program you want to debug if you have not 
done so already.

2. From the Tools menu, choose Start Debug. The Select a Program dia-
log box appears.

3. Click the program name you want to debug.

4. Click OK. The screen changes color to indicate that debug mode is 
active.

5. From the Tools menu, choose Options. The Debug/Simulation Options 
dialog box appears.

If this menu item is not available, click in the design space.

6. Click to select the Inhibit Output check box if you want to prevent the 
program from controlling outputs or changing variables while in 
debug mode. Or click to clear the Inhibit Output check box if you want 
to enable the program to control outputs or change variables. 

7. Click OK.
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8. From the Tools menu, choose Run. The program runs. Upon comple-
tion, the output value of each block is displayed (Figure 74). Use these 
values to determine if your program logic is correct.

Figure 74. TGP program in debug run or simulation mode

9. Repeat steps 3–7 until the debugging session is complete. A program 
can be debugged multiple times within a session. To adjust program 
logic or block properties, exit the debugging session.

10. From the Tools menu, choose Exit Debug. A message appears stating 
that the program was exited normally.

11. Click OK.

Simulating a program
Simulate a program to test the program logic while you are offline. In 
simulation mode, you can enter a number of different values to simulate 
various system scenarios and to verify that the program will execute with 
the desired results.

To simulate a program:

1. In the Rover Configuration Builder (the offline editor for Tracer 
MP580/581), compile and download the program you want to simulate 
if you have not done so already.

2. From the Tools menu, choose Start Simulation. The Select a Program 
dialog box appears.

3. Click the program name you want to simulate.

4. Click OK. The screen changes color to indicate that simulation mode 
is active, and the Change Value Table appears (Figure 75 on 
page 107).
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5. From the Tools menu, choose Options. The Debug/Simulation Options 
dialog box appears.

6. Type the number of cycles you want the program to execute before 
displaying the results. Click OK.

7. In the Change Value Table, double-click the values and enter new 
input values to match the test scenarios you require. 

These values are read at the start of each simulation. For certain 
items, such as program-controlled analog or binary variables, the val-
ues are likely to change. The change persists but is not reflected in 
the Change Value Table.

8. From the Tools menu, choose Run. The program executes the number 
of times you entered in the Options dialog box. Upon completion, the 
output value of each block is displayed (Figure 74 on page 106). Use 
these values to determine if your program logic is correct.

If this menu item is not available, click in the design space.

9. Repeat steps 3–8 until the testing session is complete. A program can 
be simulated multiple times within a simulation session. To adjust 
program logic or block properties, exit the simulation session.

10. From the Tools menu, choose Exit Simulation. 

11. Click OK.

Figure 75. TGP Change Value Table

Change Value Table
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Chapter 10

Network variable bindings

This chapter describes how to use network variable bindings in Tracer 
MP580/581 controller applications.

Overview
The Comm5 communications protocol allows data to be shared between 
devices (stand-alone or with a BAS) on a Comm5 network. This is called 
peer-to-peer communication. As an example of peer-to-peer communica-
tion, two or more devices serving the same space share data, such as a 
temperature reading, without having to pass the data through a BAS.

Network variables are used to share data between devices. The method 
used to direct data from one device to another is called network variable 
binding, or just binding. A network variable output from one device is 
bound to a network variable input on another device. An output variable 
from one device can be bound to input variables on many other devices. 

Network variables

Each network variable is a standard type. This standard type is referred 
to as a standard network variable type (SNVT, pronounced “snivet”). To 
bind two variables together they must be the same network variable type. 
For example, an output of type SNVT_temp_p can only be bound to an 
input of type SNVT_temp_p. For more information about SNVTs, see the 
LonMark™ Web site (www.lonmark.org). From that Web site you can 
download the official list of SNVTs.

Binding network variables

IMPORTANT
Only Comm5 devices can use network variable binding. Devices on 

other communications links do not have this capability.

BAS communications typically do not require the use of network variable 
binding because a Tracer Summit BCU will automatically bind to the 
proper data in a device. However, communications speed may be 
increased between two devices by binding their data rather than having 
the BAS read the information from one device and then broadcast it to 
another. 

Use the Rover service tool to create bindings. (See the Rover Operation 
and Programming guide, EMTX-SVX01C-EN.) 
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Tracer MP580/581 bindings
The Tracer MP580/581 controller has user-defined application software 
developed in the Tracer graphical programming (TGP) editor. The bind-
ings for this controller fall into the following two categories:

• Generic custom bindings
• Bindings associated with the Space Comfort Controller (SCC) or Dis-

charge Air Controller (DAC) profile

Generic custom bindings are made with generic network variable inputs 
and outputs. These inputs and outputs are always available on the Tracer 
MP580/581. Use network variable inputs and outputs associated with the 
SCC and DAC profiles only when their respective profile is active. See 
“Configuring an SCC or DAC profile” on page 44 for more information. 

The examples in this chapter illustrate some common applications in 
which bindings are used with the Tracer MP580/581 controller.

Receiving data

A network variable input (nvi) receives data from other devices on the 
Comm5 network. Network variable inputs (including their SNVTs) that 
are commonly used in Tracer MP580/581 bindings are shown in the fol-
lowing tables. Generic network variable inputs are shown in Table 8. 
Table 9 on page 112 contains the DAC profile network variable inputs, 
and the SCC profile network variable inputs are shown in Table 10 on 
page 114.  

Table 8. Tracer MP580/581 generic network variable inputs

Variable name SNVT Data type Description

nviSwitch01 … 
nviSwitch40

SNVT_switch Binary Bind to these 40 network variable inputs to communi-
cate binary values to the device.

nviPPM01 … 
nviPPM05

SNVT_ppm Analog Bind to these five network variable inputs to commu-
nicate concentrations in parts-per-million to the 
device. The valid range is from 0 ppm to 65535 ppm 
with a resolution of 1 ppm.

nviCount01 … 
nviCount02

SNVT_count Analog Bind to these two network variable inputs to commu-
nicate unassigned numbers to the device. The valid 
range of each variable is from 0 to 65,535 with a reso-
lution of 1.

nivCurrentAmp01 … 
nviCurrentAmp05

SNVT_amp Analog Bind to these five network variable inputs to commu-
nicate currents in amperes to the device. The valid 
range is from –3,276.8 A to 3,276.8 A with a resolu-
tion of 0.1 A.

nviCurrent_mA01 … 
nviCurrent_mA08

SNVT_amp_mil Analog Bind to these eight network variable inputs to com-
municate currents in milliamperes to the device. The 
valid range is from –3,276.8 mA to 3,276.8 mA with a 
resolution of 0.1 mA.
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nviEnergyKwh SNVT_elec_kwh Analog Bind to this network variable input to communicate 
electrical energy usage in kilo Watt-hours to the 
device.The valid range is from 0 kWh to 65,535 kWh 
with a resolution of 1 kWh.

nviEnergyWhr SNVT_elec_whr_f Analog Bind to this network variable input to communicate 
electrical energy usage in Watt-hours to the device. 
The valid range of this floating point value is from 
0 Wh to 1E38 Wh.

nviFlow01 … 
nviFlow05

SNVT_flow Analog Bind to these five network variable inputs to commu-
nicate flow rate in liters per second to the device. The 
valid range is from 0 L/s to 65,534 L/s with a resolu-
tion of 1 L/s.

nviIllum01 … 
nviIllum02

SNVT_lux Analog Bind to these two network variable inputs to commu-
nicate illuminations in lux to the device. The valid 
range is from 0 lux to 65,535 lux with a resolution of 
1 lux.

nviHeatCool01 … 
nviHeatCool20

SNVT_hvac_mode Enumerated Bind to these 20 network variable inputs to communi-
cate the application (heat/cool) modes of other 
devices to the device.

nviOccManCmd SNVT_occupancy Enumerated Bind to this network variable input to communicate 
occupancy overrides to the device.

nviOccSchedule SNVT_tod_event Enumerated Bind to this network variable input to communicate 
scheduled occupancy to the device.

nviDeviceOccup01 … 
nviDeviceOccup20

SNVT_occupancy Enumerated Bind to these 20 network variable inputs to communi-
cate the occupancy modes of other devices to the 
device.

nviPercent01 … 
nviPercent20

SNVT_lev_percent Analog Bind to these 20 network variable inputs to communi-
cate levels in percent to the device. The valid range is 
from –163.84% to 163.83% with a resolution of 
0.005%.

nviPower SNVT_power Analog Bind to this network variable input to communicate a 
power in Watts to the device. The valid range is from 
0 W to 6,553.5 W with a resolution of 0.1 W.

nviPower_f SNVT_power_f Analog Bind to this network variable input to communicate a 
power in Watts to the device. The valid range of this 
floating point value is from –1E38 W to 1E38 W.

nviPower_kilo SNVT_power_kilo Analog Bind to this network variable input to communicate a 
power in kilo Watts to the device. The valid range is 
from 0 kW to 6,553.5 kW with a resolution of 0.1 kW.

nviPressure01 … 
nviPressure05

SNVT_press_p Analog Bind to these five network variable inputs to commu-
nicate pressures in Pascals to the device. The valid 
range is from –32,768 Pa to 32,766 Pa with a resolu-
tion of 1 Pa.

Table 8. Tracer MP580/581 generic network variable inputs (Continued)

Variable name SNVT Data type Description
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nviTemp01 … 
nviTemp40

SNVT_temp_p Analog Bind to these 40 network variable inputs to communi-
cate temperatures in degrees Celsius to the device. 
The valid range is from –273.17°C to 327.66°C with a 
resolution of 0.01°C.

nviUnitStatus01 … 
nviUnitStatus20

SNVT_hvac_status Enumerated
Analog
Binary

Bind to this network variable to communicate status 
of other control units. The enumerated range is from 
0 to 11, which indicates the mode of the controller 
(see description of SNVT_hvac_mode in this table). 
Analog values have a range of –163.83% to 183.83%.

nviVolts01 … 
nviVolts08

SNVT_volt Analog Bind to these eight network variable inputs to com-
municate voltages in volts to the device. The valid 
range is from –3,276.8 V to 3,276.8 V with a resolution 
of 0.1 V.

nviVolt_f SNVT_volt_f Analog Bind to this network variable input to communicate a 
voltage in volts to the device. The valid range of this 
floating point value is from –1E38 V to 1E38 V.

Table 9. Tracer MP580/581 DAC profile network variable inputs

Variable name SNVT Data type Description

nviOccSchedule SNVT_tod_event Enumerated Bind to this network variable input to communicate 
scheduled occupancy to the device.

nviOccManCmd SNVT_occupancy Enumerated Bind to this network variable input to communicate 
occupancy overrides to the device.

nviApplicMode SNVT_hvac_mode Enumerated Bind to this network variable input to communicate 
the application mode to the device.

nviValveOverride* SNVT_hvac_overid (Structure) Bind to this network variable input to communicate 
water valve overrides to the device.

nviEmergOverride SNVT_hvac_emerg Enumerated Bind to this network variable input to communicate 
emergency overrides to the device.

nviDuctStatPress SNVT_press_p Analog Bind to this network variable input to communicate 
the duct static pressure in Pascals to the device. The 
valid range is from –32,768 Pa to 32,766 Pa with a res-
olution of 1 Pa.

nviDuctStaticSP SNVT_press_p Analog Bind to this network variable input to communicate 
the duct static pressure setpoint in Pascals to the 
device. The valid range is from –32,768 Pa to 
32,766 Pa with a resolution of 1 Pa.

nviDAClSP SNVT_temp_p Analog Bind to this network variable input to communicate 
the discharge air cooling setpoint in degrees Celsius 
to the device. The valid range is from –273.17°C to 
327.66°C with a resolution of 0.01°C.

* The variable nviValveOverride contains structures. This variable cannot be viewed on the operator display.
Note: For more information on network variable inputs associated with the DAC profile, see the LonMark™ Functional Profile: 

Discharge Air Controller. For more information about standard network variable types (SNVTs), see the SNVTs and SCPTs in 
the Device Resource Files on the LonMark™ Web site at www.lonmark.org.

Table 8. Tracer MP580/581 generic network variable inputs (Continued)

Variable name SNVT Data type Description
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nviDAHtSP SNVT_temp_p Analog Bind to this network variable input to communicate 
the discharge air heating setpoint in degrees Celsius 
to the device. The valid range is from –273.17°C to 
327.66°C with a resolution of 0.01°C.

nviBldgStatPress SNVT_press_p Analog Bind to this network variable input to communicate 
the building static pressure in Pascals to the device. 
The valid range is from –32,768 Pa to 32,766 Pa with a 
resolution of 1 Pa.

nviBldgStaticSP SNVT_press_p Analog Bind to this network variable input to communicate 
the building static pressure setpoint in Pascals to the 
device. The valid range is from –32,768 Pa to 
32,766 Pa with a resolution of 1 Pa.

nviOAMinPos SNVT_lev_percent Analog Bind to this network variable input to communicate 
the outdoor air damper minimum position to the 
device. The valid range is from –163.84% to 163.83% 
with a resolution of 0.005%.

nviOutdoorTemp SNVT_temp_p Analog Bind to this network variable input to communicate 
the outdoor air temperature in degrees Celsius to the 
device. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C.

nviSpaceTemp SNVT_temp_p Analog Bind to this network variable input to communicate 
the space temperature in degrees Celsius to the 
device. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C.

nviSpaceRH SNVT_lev_percent Analog Bind to this network variable input to communicate 
the space relative humidity in percent to the device. 
The valid range is from –163.84% to 163.83% with a 
resolution of 0.005%.

Table 9. Tracer MP580/581 DAC profile network variable inputs (Continued)

Variable name SNVT Data type Description

* The variable nviValveOverride contains structures. This variable cannot be viewed on the operator display.
Note: For more information on network variable inputs associated with the DAC profile, see the LonMark™ Functional Profile: 

Discharge Air Controller. For more information about standard network variable types (SNVTs), see the SNVTs and SCPTs in 
the Device Resource Files on the LonMark™ Web site at www.lonmark.org.
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Table 10. Tracer MP580/581 SCC profile network variable inputs

Variable name SNVT Data type Description

nviSpaceTemp SNVT_temp_p Analog Bind to this network variable input to communicate 
the space temperature in degrees Celsius to the 
device. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C.

nviSetpoint SNVT_temp_p Analog Bind to this network variable input to communicate 
the space temperature setpoint in degrees Celsius to 
the device. The valid range is from –273.17°C to 
327.66°C with a resolution of 0.01°C.

nviOccSchedule SNVT_tod_event Enumerated Bind to this network variable input to communicate 
scheduled occupancy to the device.

nviOccManCmd SNVT_occupancy Enumerated Bind to this network variable input to communicate 
occupancy overrides to the device.

nviOccSensor SNVT_occupancy Enumerated Bind to this network variable input to communicate 
the value of an occupancy sensor to the device.

nviApplicMode SNVT_hvac_mode Enumerated Bind to this network variable input to communicate 
the application mode to the device.

nviValveOverride* SNVT_hvac_overid (Structure) Bind to this network variable input to communicate 
water valve overrides to the device.

nviFlowOverride* SNVT_hvac_overid (Structure) Bind to this network variable input to communicate air 
flow overrides to the device.

nviEmergOverride SNVT_hvac_emerg Enumerated Bind to this network variable input to communicate 
emergency overrides to the device.

nviOutdoorTemp SNVT_temp_p Analog Bind to this network variable input to communicate 
the outdoor air temperature in degrees Celsius to the 
device. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C.

nviSpaceRH SNVT_lev_percent Analog Bind to this network variable input to communicate 
the space relative humidity in percent to the device. 
The valid range is from –163.84% to 163.83% with a 
resolution of 0.005%.

nviSpaceCO2 SNVT_ppm Analog Bind to this network variable input to communicate 
the space concentration of carbon dioxide (CO2) in 
parts-per-million to the device. The valid range is from 
0 ppm to 65,535 ppm with a resolution of 1 ppm.

* The variables nviValveOverride and nviFlowOverride contain structures. These variables cannot be viewed on the operator 
display.

Note: For more information on network variable inputs associated with the SCC profile, see the LonMark™ Functional Profile: 
Space Comfort Controller. For more information about standard network variable types (SNVTs), see the SNVTs and 
SCPTs in the Device Resource Files on the LonMark™ Web site at www.lonmark.org.
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Sending data

A network variable output (nvo) sends data to other devices on the 
Comm5 network. The network variable outputs (including their SNVTs) 
that are commonly used in Tracer MP580/581 bindings are shown in the 
following tables. Generic network variable inputs are shown in Table 11. 
Table 12 on page 116 contains the DAC profile network variable outputs, 
and the SCC profile network variable inputs are shown in Table 13 on 
page 117.   

Table 11. Tracer MP580/581 generic network variable outputs

Variable name SNVT Data type Description

nvoSwitch01 … 
nvoSwitch40

SNVT_switch Binary These 40 network variable outputs communicate 
binary values to other devices.

nvoPPM01 … 
nvoPPM05

SNVT_ppm Analog These five network variables outputs communicate 
concentrations in parts-per-million to other devices. 
The valid range is from 0 ppm to 65,535 ppm with a 
resolution of 1 ppm.

nvoCount01 … 
nvoCount02

SNVT_count Analog These two network variable outputs communicate 
unsigned numbers to other devices. The valid range 
of each variable is from 0 to 65,535 with a resolution 
of 1.

nvoCurrent_mA01 … 
nvoCurrent_mA05

SNVT_amp_mil Analog These five network variable outputs communicate 
currents in milliamperes to other devices. The valid 
range is from –3,276.8 mA to 3,276.8 mA with a reso-
lution of 0.01 mA.

nvoFlow01 … 
nvoFlow05

SNVT_flow Analog These five network variable outputs communicate the 
flow rates in liters per second to other devices. The 
valid range is from 0 L/s to 65,534 L/s with a resolu-
tion of 1 L/s.

nvoOccManCmd SNVT_occupancy Enumerated This network variable output communicates occu-
pancy overrides to other devices. Avoid controlling 
this from a program.

nvoOccSchedule SNVT_tod_event Enumerated This network variable output communicates sched-
uled occupancy to other devices. Avoid controlling 
this from a program.

nvoBypassTime SNVT_time_min Analog This network variable output communicates the 
remaining occupied bypass time to other devices.

nvoOccupancy SNVT_occupancy Enumerated This network variable output communicates occu-
pancy mode as defined by custom programming to 
other devices.

nvoOccTOD SNVT_tod_event Enumerated This network variable output communicates occu-
pancy mode as defined by custom programming to 
other devices.

nvoEffectOccup SNVT_occupancy Enumerated This network variable output communicates effective 
occupancy mode to other devices. Avoid controlling 
this from a program (see Table 2 on page 62 for 
details).
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nvoPercent01 … 
nvoPercent20

SNVT_lev_percent Analog These 20 network variable outputs communicate lev-
els in percent to other devices. The valid range is from 
–163.84% to 163.83% with a resolution of 0.005%.

nvoPressure01 … 
nvoPressure05

SNVT_press_p Analog These five network variable outputs communicate 
pressures in Pascals to other devices. The valid range 
is from –32,768 Pa to 32,766 Pa with a resolution of 
1 Pa.

nvoLinRes01 … 
nvoLinRes05

SNVT_res_f Analog These five network variable outputs communicate a 
resistance in ohms to other devices. The valid range 
of this floating point value is from –1E38 Ω to 1E38 Ω.

nvoTemp01 … 
nvoTemp40

SNVT_temp_p Analog These 40 network variable outputs communicate tem-
peratures in degrees Celsius to other devices. The 
valid range is from –273.17°C to 327.66°C with a reso-
lution of 0.01°C. 

nvoVolts01 … 
nvoVolts05

SNVT_volt Analog These five network variable outputs communicate 
voltages in volts to other devices. The valid range is 
from –3,276.8 V to 3,276.8 V with a resolution of 0.1 V.

Table 12. Tracer MP580/581 DAC profile network variable outputs

Variable name SNVT Data type Description

nvoDischAirTemp SNVT_temp_p Analog This network variable output communicates the dis-
charge air temperature in degrees Celsius to other 
devices. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C.

nvoUnitStatus* SNVT_hvac_status (Structure) This network variable output communicates unit status 
information to other devices.

nvoEffDATempSP SNVT_temp_p Analog This network variable output communicates the effective 
discharge air temperature setpoint in degrees Celsius to 
other devices. The valid range is from –273.17°C to 
327.66°C with a resolution of 0.01°C.

nvoDuctStatPress SNVT_press_p Analog This network variable output communicates duct static 
pressure in Pascals to other devices. The valid range is 
from –32,768 Pa to 32,766 Pa with a resolution of 1 Pa.

nvoEffDuctStatSP SNVT_press_p Analog This network variable output communicates the effective 
duct static pressure setpoint in Pascals to other devices. 
The valid range is from –32768 Pa to 32766 Pa with a res-
olution of 1 Pa.

nvoApplicMode SNVT_hvac_mode Enumerated This network variable output communicates the applica-
tion mode of the device.

nvoEffectOccup SNVT_occupancy Enumerated This network variable output communicates the effective 
occupancy mode of the device. Avoid controlling this 
from a program.

* The variable nvoUnitStatus contains structures. It cannot be viewed on the operator display.
Note: For more information on network variable outputs associated with the DAC profile, see the LonMark™ Functional Profile: 

Discharge Air Controller. For more information on any standard network variable types (SNVTs), see SNVTs and SCPTs in the 
Device Resource Files on the LonMark™ Web site at www.lonmark.org.

Table 11. Tracer MP580/581 generic network variable outputs (Continued)

Variable name SNVT Data type Description
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nvoExhFanStatus SNVT_switch Binary This network variable outputs communicates the exhaust 
fan status of the device.

nvoRetFanStatus SNVT_switch Binary This network variable outputs communicates the return 
fan status of the device.

nvoBldgStatPress SNVT_press_p Analog This network variable output communicates the building 
static pressure in Pascals to other devices. The valid 
range is from –32,768 Pa to 32,766 Pa with a resolution of 
1 Pa.

nvoOAFlow SNVT_flow Analog This network variable output communicates the outdoor 
air flow rate in liters per second to other devices. The 
valid range is from 0 L/s to 65,534 L/s with a resolution of 
1 L/s.

nvoMATemp SNVT_temp_p Analog This network variable output communicates the mixed 
air temperature in degrees Celsius to other devices. The 
valid range is from –273.17°C to 327.66°C with a resolu-
tion of 0.01°C.

nvoSpaceTemp SNVT_temp_p Analog This network variable output communicates the space 
temperature in degrees Celsius to other devices. The 
valid range is from –273.17°C to 327.66°C with a resolu-
tion of 0.01°C.

nvoSpaceRH SNVT_lev_percent Analog This network variable output communicates the space 
relative humidity in percent to other device. The valid 
range is from –163.84% to 163.83% with a resolution of 
0.005%.

Table 13. Tracer MP580/581 SCC profile network variable outputs

Variable name SNVT Data type Description

nvoSpace Temp SNVT_temp_p Analog This network variable output communicates the space 
temperature in degrees Celsius to other devices. The 
valid range is from –273.17°C to 327.66°C with a resolu-
tion of 0.01°C. 

nvoUnitStatus* SNVT_hvac_status (Structure) This network variable output communicates unit status 
information to other devices.

nvoEffectSetpt SNVT_temp_p Analog This network variable output communicates the effective 
setpoint in degrees Celsius to other devices. The valid 
range is from –273.17°C to 327.66°C with a resolution of 
0.01°C. 

nvoEffectOccup SNVT_occupancy Enumerated This network variable output communicates the effective 
occupancy mode of the device. Avoid controlling this 
from a program.

* The variable nvoUnitStatus contains structures. It cannot be viewed on the operator display.
Note: For more information on network variable outputs associated with the SCC profile, see the LonMark™ Functional Profile: 

Space Comfort Controller. For more information on any standard network variable types (SNVTs), see SNVTs and SCPTs in the 
Device Resource Files on the LonMark™ Web site at www.lonmark.org.

Table 12. Tracer MP580/581 DAC profile network variable outputs (Continued)

Variable name SNVT Data type Description

* The variable nvoUnitStatus contains structures. It cannot be viewed on the operator display.
Note: For more information on network variable outputs associated with the DAC profile, see the LonMark™ Functional Profile: 

Discharge Air Controller. For more information on any standard network variable types (SNVTs), see SNVTs and SCPTs in the 
Device Resource Files on the LonMark™ Web site at www.lonmark.org.
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Examples of network variable bindings
The following examples show four common uses of bindings in Tracer 
MP580/581 applications.

Example 1: Display sensor readings from a Tracer 

MP503 on a Tracer MP581 operator display

In this example, four different sensors are connected to a Tracer MP503 
input/output (I/O) module. A thermistor reading the outside air tempera-
ture is connected to universal input 1 on the Tracer MP503. A 4–20 mA 
sensor reading the outside air humidity is connected to universal input 2. 
Two binary inputs from a fire panel (Alarm Status and Fire Panel Trou-
ble) are connected to universal input 3 and universal input 4, respectively. 
A Tracer MP581 controller is on the same Comm5 link as the Tracer 
MP503. The Tracer MP581 is controlling an air-handling unit (AHU). The 
outside air enthalpy is required to control the economizer on the AHU.

The building operator also wants to know the outside air temperature 
and humidity, so those values should be displayed on the operator display 
of the Tracer MP581. The location of the outside air sensors made it con-
venient to wire those points to the Tracer MP503 also.

Use bindings to allow the economizer control in the Tracer MP581 to cal-
culate outside air enthalpy and to display the four inputs from the Tracer 
MP503 on the operator display of the Tracer MP581. Figure 76 on 
page 119 shows the Comm5 network for this example.

nvoDischAirTemp SNVT_temp_p Analog This network variable output communicates the dis-
charge air temperature in degrees Celsius to other 
devices. The valid range is from –273.17°C to 327.66°C 
with a resolution of 0.01°C. 

nvoSpaceRH SNVT_lev_percent Analog This network variable output communicates the space 
relative humidity in percent to the devices. The valid 
range is from –163.84% to 163.83% with a resolution of 
0.005%.

nvoSpaceCO2 SNVT_ppm Analog This network variable output communicates the space 
concentration of carbon dioxide (CO2) in parts-per-million 
to other devices. The valid range is from 0 ppm to 
65,535 ppm with a resolution of 1 ppm.

nvoMATemp SNVT_temp_p Analog This network variable output communicates the mixed 
air temperature in degrees Celsius to other devices. The 
valid range is from –273.17°C to 327.66°C with a resolu-
tion of 0.01°C. 

Table 13. Tracer MP580/581 SCC profile network variable outputs (Continued)

Variable name SNVT Data type Description

* The variable nvoUnitStatus contains structures. It cannot be viewed on the operator display.
Note: For more information on network variable outputs associated with the SCC profile, see the LonMark™ Functional Profile: 

Space Comfort Controller. For more information on any standard network variable types (SNVTs), see SNVTs and SCPTs in the 
Device Resource Files on the LonMark™ Web site at www.lonmark.org.
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Figure 76. Comm5 network for example 1

Use the Rover service tool to create bindings. (See the Rover Operation 
and Programming guide, EMTX-SVX01C-EN.) Using the Rover service 
tool, select the network variable from the Tracer MP503 and then select 
the Tracer MP581. The Rover service tool shows you only the variables in 
the Tracer MP581 of the SNVT that matches the variable you selected in 
the Tracer MP503.

Table 14 shows the bindings needed.

Once you have completed the bindings, program the Tracer MP581 to dis-
play this data on the operator display. Remember that the outside air 
humidity is being transmitted over the network in units of mA. Some cus-
tom programming is required in the Tracer MP581 to convert the humid-
ity from units of mA to units of percent (%). Custom programming in the 
Tracer MP581 will also use the outside air temperature and humidity to 
calculate the outside air enthalpy and use it to control the economizer of 
the AHU. See Figure 77 on page 120 for a sample program written in the 
TGP editor.

Table 14. Bindings for example 1

Network variable output on the 
Tracer MP503

Network variable input on 
the Tracer MP581

nvoTemperature1 binds to nviTemp011

nvoCurrent2 binds to nviCurrent_mA012

nvoBIP3Status binds to nviSwitch013

nvoBIP4Status binds to nviSwitch013

1 The Tracer MP581 has 40 generic temperature (SNVT_temp_p) network variable 
inputs available for binding (nviTemp01 through nviTemp40). 

2 The Tracer MP581 has 8 generic current (SNVT_amp_mil) network variable inputs 
available for binding (nviCurrent_mA01 through nviCurrent_mA08).

3 The Tracer MP581 has 40 generic binary (SNVT_switch) network variable inputs 
available for binding (nviSwitch01 through nviSwitch40). 

®

Comm5 link

Tracer MP503

Tracer MP581 with 
operator display

Additional 
LonTalk 
devices
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Figure 77. Program for example 1

Example 2: Display sensor readings from a Tracer 

MP503 on two different Tracer MP581 operator displays

This example builds on example 1 and shows that bindings can be “one to 
many.” In this example, a second Tracer MP581 controller is added to the 
system described in example 1. The second Tracer MP581 also controls an 
AHU. This AHU also requires the outside air enthalpy in order to control 
its economizer. As in example 1, use bindings to allow the economizer con-
trol in the second Tracer MP581 to calculate outside air enthalpy. 
Figure 78 on page 121 shows the Comm5 network for this example.
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Figure 78. Comm5 network for example 2

Use the Rover service tool to create bindings. (See the Rover Operation 
and Programming guide, EMTX-SVX01E-EN.) Using the Rover service 
tool, select the network variable from the Tracer MP503 and then select 
the second Tracer MP581. The Rover service tool shows you only the vari-
ables in Tracer MP581 #2 of the SNVT that matches the variable you 
selected in the Tracer MP503. 

Table 15 shows the bindings needed between the Tracer MP503 I/O mod-
ule and Tracer MP581 #2.

Again, after you have completed the bindings, program Tracer MP581 #2 
to calculate enthalpy from the outside air temperature and humidity. 
Custom programming is also required to display this data on the operator 
display of Tracer MP581 #2. Remember that the outside air humidity is 
being transmitted over the network in units of mA. Some custom pro-
gramming is required in Tracer MP581 #2 to convert the humidity from 
units of mA to units of percent (%) before performing the enthalpy calcu-
lation. See Figure 79 on page 122 for a sample program written in the 
TGP editor.

Table 15. Bindings for example 2

Network variable output on 
the Tracer MP503

Network variable input on 
Tracer MP581 #2

nvoTemperature1 binds to nviTemp011

nvoCurrent2 binds to nviCurrent_mA012

1 The Tracer MP581 has 40 generic temperature (SNVT_temp_p) network variable 
inputs available for binding (nviTemp01 through nviTemp40).

2 The Tracer MP581 has 8 generic current (SNVT_amp_mil) network variable inputs 
available for binding (nviCurrent_mA01 through nviCurrent_mA08).

®

Comm5 link

Tracer MP503

Tracer MP581 #1 
with operator display

Tracer MP581 #2 
with operator display

Additional 
LonTalk 
devices
CNT-SVP01C-EN 121



Chapter 10 Network variable bindings
Figure 79. Program for example 2

Example 3: Control a binary output on the Tracer 

MP503 from a Tracer MP581

This example shows an nvi on the Tracer MP503 I/O module being bound, 
which allows a binary output on the Tracer MP503 to be controlled by 
another device on the Comm5 network. In this example, binary output 1 
on the Tracer MP503 is starting and stopping an exhaust fan. The Tracer 
MP503 is communicating through the Comm5 network to a Tracer 
MP581 controller that is controlling an AHU. The AHU and the exhaust 
fan follow the same schedule; for example, whenever the AHU runs, the 
exhaust fan runs. 

Bind an nvo on the Tracer MP581 to an nvi on the Tracer MP503 so the 
AHU and exhaust fan run together. Figure 80 shows the Comm5 network 
for this example.

Figure 80. Comm5 network for example 3

®

Comm5 link

Tracer MP503

Tracer MP581 with 
operator display

Additional 
LonTalk 
devices
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Use the Rover service tool to create bindings. (See the Rover Operation 
and Programming guide, EMTX-SVX01C-EN.) Using the Rover service 
tool, select the network variable from the Tracer MP581 and then select 
the Tracer MP503. The Rover service tool shows you only the variables in 
the Tracer MP503 of the SNVT that matches the variable you selected in 
the Tracer MP581. 

Table 16 shows the bindings needed.

Custom programming in the Tracer MP581 controls nvoSwitch01. Write 
a custom program to control nvoSwitch01 on when the AHU is on, and 
has been on for 30 seconds, and off when the AHU is off. The network 
binding passes the command to the binary output on the Tracer MP503. 
See Figure 81 for a sample program written in the TGP editor.

Figure 81. Program for example 3

Example 4: Use a sensor reading on a Tracer MP503 to 

control a pump VFD on a Tracer MP581

In this example, a Tracer MP581 controller is controlling the variable fre-
quency drive (VFD) of a chilled water pump. We want to use a differential 
pressure sensor (4–20 mA output) to control the speed of this pump. 
Unfortunately, the differential pressure sensor is located more than 
1,000 ft away from the pump, so it cannot be wired directly to the univer-
sal input on the Tracer MP581. Install a Tracer MP503 I/O module to 
read the differential pressure and then use network bindings to send the 
pressure value to the Tracer MP581 controlling the chilled water pump 
VFD. 

Figure 82 on page 124 shows the Comm5 network for this example.

Table 16. Bindings for example 3

Network variable output on 
the Tracer MP581

Network variable input on 
the Tracer MP503

nvoSwitch011 binds to nviBOP1Request
1 The Tracer MP581 has 40 generic binary (SNVT_switch) network variable outputs 

available for binding (nvoSwitch01 through nvoSwitch40). 
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Figure 82. Comm5 network for example 4

Use the Rover service tool to create bindings. (See the Rover Operation 
and Programming guide, EMTX-SVX01C-EN.) Using the Rover service 
tool, select the network variable from the Tracer MP503 and then select 
the Tracer MP581. The Rover service tool shows you only the variables in 
the Tracer MP581 of the SNVT that matches the variable you selected in 
the Tracer MP503.

Table 17 shows the bindings needed.

Once you have completed the bindings, you need to program the Tracer 
MP581 to use this data to control the pump speed. Remember that the 
differential pressure is being transmitted over the network in units of 
mA. Some custom programming is required in the Tracer MP581 to con-
vert the differential pressure from units of mA to the proper units of pres-
sure. Custom programming in the Tracer MP581 will then use the 
pressure to control the speed of the chilled water pump. See Figure 83 on 
page 125 for a sample program written in the TGP editor.

Table 17. Bindings for example 4

Network variable output on 
the Tracer MP503

Network variable input on the 
Tracer MP581

nvoCurrent1 binds to nviCurrent_mA011

1 The Tracer MP581 has 8 generic current (SNVT_amp_mil) network variable inputs 
available for binding (nviCurrent_mA01 through nviCurrent_mA08).

®

Comm5 link

Tracer MP503

Tracer MP581 with 
operator display

Additional 
LonTalk 
devices
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Figure 83. Program for example 4
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program pages, 81
schedule exception, 56
start/stop time, 52

closing programs, 91

CO2 limit, 44

Comm5 parameters
viewing, 13

comments, adding, 84

communications loss value
analog variables, 34
binary variables, 32

compare toolbar, 75

compiling a program, 93

configuration reports
printing, 46
savings, 46

configuring
analog inputs, 23
analog outputs, 28
analog variables, 32
binary inputs, 21
binary outputs, 27
binary variables, 30
block properties, 83
building static pressure 

setpoint, 46
calculations, 66
CO2 limit, 44
custom displays, 38, 40
daily schedule, 50
damper minimum position, 44
date, 36
default setpoints, 44, 45
Discharge Air Controller, 45
discharge air setpoints, 45
duct static pressure, 46
EX2 expansion module, 19
exception schedule, 54, 57
home display, 38
network interface, 43
occupancy inputs, 57
occupancy sensor, 58
occupied bypass timer, 37, 44, 

46
operator display, 38
outdoor air temperature 

setpoint, 46
program properties, 80
pulse inputs, 25
relative humidity setpoint, 44
Space Comfort Controller, 43
time, 36
timed override input, 58
timers, 37
user security, 34

connecting blocks, 85, 86

connections, analog and binary, 86

Constant block, 100

control source
analog variables, 33
binary variables, 31
occupancy, 16, 59
outputs, 5, 6

controller
see Tracer MP580/581

converting calculation values, 68

copying
daily schedule, 53

current-period value, 68, 69

custom displays
adding items, 41
configuring, 38, 40
naming, 41
selecting item type, 41
setting adjustable, 42
setting low/high limits, 42
viewing, 14

D

DAC
see Discharge Air Controller

daily schedule
adding second start/stop times, 

50
clearing all daily even times, 53
clearing daily event, 52
clearing start/stop time, 52
configuring, 50
copying, 53
setting number of days, 50

damper minimum position, 44

date
configuring, 36
viewing current, 3, 12, 49

day of month, resetting 
calculations, 68

debugging a program, 95

decimal places
analog inputs, 24
analog outputs, 29
analog variables, 34

DeEnumerator block, 100
128 CNT-SVP01C-EN



Index
deleting
see clearing

descriptions, program, 81

descriptors
binary inputs, 22
binary outputs, 28
binary variables, 32

design space, 72

device
see Tracer MP580/581

diagnostics, 3

digits right of decimal
analog inputs, 24
analog outputs, 29
analog variables, 34

Discharge Air Controller
configuring interface, 45
network variable inputs, 112
network variable outputs, 116
setting network interface, 43

discharge air setpoints, 45

display units
see units (display)

displays
see custom displays; home 

display

downloading a program, 93

duct static pressure limit, 46

duct static pressure setpoint, 46

dwell time, 25

E

editing
see configuring

enable output control, 95

end of range, analog inputs, 25

enumerated output, 99

Equal block, 100

event trigger, 80

EX2 expansion module
configuring, 19
viewing communication status, 

3

exception schedule
adding an exception, 54, 55
adding second start/stop times, 

55
clearing an exception, 56

configuring, 54
editing an exception, 57
naming an exception, 55

execution, program, 80

expansion module
see EX2 expansion module

F

fan request, 99

Feedback Input, 105

firmware
flash download, 47

flash download new firmware, 47

function toolbar, 76

G

graphical programming
see Tracer graphical 

programming

H

hardware inputs
see inputs (hardware)

hardware outputs
see outputs (hardware)

help, 2, 74, 99

holiday
see exception schedule

home display
adding items, 39
configuring, 38
naming, 39
overview, 38
selecting item type, 39

I

inhibiting output control, 95

initial value
analog variables, 34
binary variables, 32

input/output toolbar, 75

inputs (hardware)
configuring, 21
increasing number of, 19
using in calculations, 68

viewing status, 4
see also analog inputs; binary 

inputs; pulse inputs

K

keyboard short cuts, 77

L

last day of month, resetting 
calculations, 68

last-period value, 68, 69

limit
duct static pressure, 46
high and low, 42

local variables
see analog variables; binary 

variables

logic toolbar, 75

LonMark™, 109, 112, 113, 116, 117

M

margins, paper, 82

math toolbar, 75

memory reset of controller, 47

menu bar, 73

minimum on/off timers, binary 
outputs, 28

mixed air temperature low-limit 
setpoint, 46

moving blocks, 84

MP580/581, see Tracer MP580/581

N

naming
analog inputs, 23
analog outputs, 29
analog variables, 33
binary inputs, 22
binary outputs, 28
binary variables, 31
calculations, 67
custom displays, 41
home display, 39
programs, 81
pulse inputs, 26
schedule exception, 55
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users, 35

network interface, 43

network variable bindings
examples, 118-124
overview, 109
using with a BAS, 109

network variable inputs, 67, 110
DAC profile, 112
nviOccManCmd, 59
nviOccSchedule, 60
nviOccSensor, 60
SCC profile, 113

network variable outputs
DAC profile, 116
generic, 115
nvoEffectOccup, 62
SCC profile, 117

network variables, 109
inputs, 110
outputs, 115-118
standard types, 109

nvi, 110

nviOccManCmd, 59

nviOccSchedule, 60

nviOccSensor, 60

nvo, 115

nvoEffectOccup, 62

O

occupancy
controlling, 59
occupied bypass mode, 99
occupied mode, 99
occupied standby mode, 99
overriding, 16
unoccupied mode, 99

Occupancy block, 99, 100

occupancy inputs
configuring, 57
occupancy sensor, 58
timed override input, 58

occupancy sensor, 58

occupied bypass mode, 57, 99

occupied bypass timer, 37, 44, 46, 
61

occupied mode, 99

occupied standby mode, 99

online Help, 2, 74, 99

opening
existing TGP programs, 79
new TGP program, 71, 79

operating status, 3

operator display
configuring, 38
viewing custom displays, 14
see also home display; custom 

displays

orientation, paper, 82

outdoor air temperature setpoint, 
46

output display, 72

outputs (hardware)
configuring, 27
control source, 5
increasing number of, 19
viewing status, 5
see also analog outputs; binary 

outputs

overriding
controller occupancy, 16
variables, 15

P

page size and layout, 82

pages, program, 81

password, 34

peer-to-peer communication, 109

PID block, 103

platinum RTD, 24

plug-in
see Rover service tool

power-up control wait time, 37

precision
see decimal places

print setup, 82

printing configuration reports, 46

printing programs, 91

priority control, 59

priority control table, 62

profile
see Space Comfort Controller; 

Discharge Air Controller

program execution
enabling output control, 95
stopping output control, 95
see also debugging a program

program properties
editing, 80
naming, 81
program execution, 80
setting number of pages, 81
writing descriptions, 81

program toolbar, 76

programming
see Tracer graphical 

programming

proportional, integral, derivative
see PID block

pulse inputs
configuring, 25
naming, 26
setting display units, 26
setting pulse weight, 26

pulse weight, 26

R

refreshing TGP editor, 91

relative humidity setpoint, 44

releasing, occupancy override, 17

removing
see clearing

reports
printing, 46
saving, 46

reset controller memory, 47

resetting calculation values, 68

resistance temperature detector, 24

Rover service tool
online Help, 2
overview, 1
plug-in, 1
user guide, 1
using, 1

RTD, 24

run frequency, 80, 81

run hours and starts, 66, 67

S

saving configuration reports, 46

saving program, 91

SCC
see Space Comfort Controller
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Schedule application
configuring exception schedule, 

54
setting up daily schedule, 50
viewing status, 12, 49
see also daily schedule; 

exception schedule

second start/stop times, 50, 55

secondary control device, 30

security
configuring, 34
editing password, 35
naming users, 35
setting user access, 36

selecting blocks, 84

sensor outputs, analog inputs, 25

sensor values, analog inputs, 25

service tool
see Rover service tool

setpoint
building static pressure, 46
default, 44, 45
discharge air, 45
duct static pressure, 46
mixed air temperature low limit, 

46
outdoor air temperature, 46

setpoint adjustment, 99

setting up
see configuring

short cuts, keyboard, 77

shortcut menu, 77

simulating a program, 96

SNVT
see standard network variable 

type

source
see control source

Space Comfort Controller
configuring interface, 43
network variable inputs, 113
network variable outputs, 117
setting network interface, 43

standard applications
see Schedule application; 

Calculations application

standard network variable type, 109

standard toolbar, 74

starts and run hours, 66, 67

start-up, program execution, 80

status
Calculations application, 12, 65
custom displays, 14
device, 3
EX2 expansion module 

communication, 3
inputs (hardware), 4
outputs (hardware), 5
program, 94
Schedule application, 12, 49
unit, 3
variables, 9

Summit
see Tracer Summit

Switch block, 100

synchronizing time with BAS, 59

T

test toolbar, 76

TGP
see Tracer graphical 

programming

time
configuring, 36
setting Daylight Savings Time, 

37
synchronizing with BAS, 59
viewing current, 3, 12, 49

time delay toolbar, 76

timed override input, 58

timers, 37, 61

today value, 68, 69

toolbars
alignment, 74
calculation, 75
compare, 75
function, 76
input/output, 75
logic, 75
math, 75
program, 76
showing and hiding, 76
standard, 74
test, 76
time delay, 76

totalizing, 66, 67

Tracer graphical programming
closing, 91
compiling, 93
debugging, 95

design space, 72
downloading, 93
keyboard short cuts, 77
menu bar, 73
opening existing programs, 79
opening new programs, 71, 79
output display, 72
overview, 71
page size and layout, 82
printing programs, 91
refreshing, 91
saving programs, 91
shortcut menu, 77
simulation, 96
toolbars, 75-76
uploading, 94
viewing program status, 94
see also program properties; 

blocks

Tracer MP580/581
device status, 3
example use with network 

variable bindings, 118-124
overriding occupancy, 16
overview, 1
see also configuring

Tracer Summit
binding network variables, 109
controlling occupancy, 59
controlling outputs, 5
controlling variables, 9-11, 30-

34
scheduling, 49, 59
synchronizing time, 59
totalizing, 65

Tracer Summit variables
see analog variables; binary 

variables

type
analog outputs, 29
calculations, 67

U

unit status, 3

units (display)
analog inputs, 24
analog outputs, 29
analog variables, 33
calculation output, 68
Discharge Air Controller, 45
pulse inputs, 26
Space Comfort Controller, 44
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unoccupied mode, 99

uploading a program, 94

user access, 36

user name, 35

user password, 34

V

variables
see analog variables; binary 

variables; network variables

viewing
Calculations application, 12, 65
Comm5 parameters, 13
current date, 3, 49
current time, 3, 49
custom displays, 14
diagnostics, 3
EX2 expansion module 

communication status, 3
inputs (hardware), 4
outputs (hardware), 5
program status, 94
Schedule application, 49
Schedule status, 12
unit status, 3
variables, 9

W

What’s This? help, 2, 74

wire, 86

wired connections, 85

wireless connections, 86

writing program descriptions, 81

Y

yesterday value, 68, 69
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